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Important Notice

The IVVet Infusion Pump User Manual is delivered subject to the conditions and
restrictions listed in this section. Clinicians and qualified hospital staff should read the
entire User Manual prior to operating the IVVet pump in order to fully understand the
functionality and operating procedures of the pump and its accessories.

®  Improper programming may cause injury to the patient.

Prescription Notice

Federal United States law restricts this device for sale by or on the order of a physician
only {21 CFR 801.109(b) (1)}.

The IVVet pump is for use at the direction of, or under the supervision of, licensed
physicians and/or licensed healthcare professionals who are trained in the use of the
pump and in the administration of blood, medication and parenteral nutrition. The
instructions for use presented in this manual should in no way supersede established
medical protocol concerning patient care.

Copyright, Trademark and Patent
Information

© 2017, Q Core Medical Ltd. All right reserved.
IVWet and Q Core (with or without logos) are trademarks of Q Core Medical Ltd.

The design, pumping mechanism and other features of the [VVet pump are protected
under one or more US and Foreign Patents.



Disclaimer

The information in this manual has been carefully examined and is believed to be
reliable. No responsibility is assumed for any inadvertent inaccuracies. Q Core Medical
Ltd. reserves the right to make changes to any of its products in order to improve
reliability, design and performance. The instructions presented in this manual should in
no way supersede established medical protocol concerning patient care. The text and
drawings herein are for the purposes of illustration and reference only; the
specifications on which they are based are subject to change without notice.

Warning

Use only Q Core Medical Ltd. supplied administration sets and accessories with the
IVVet pump. Use of administration sets other than Q Core Medical Ltd. supplied sets
may impair the operation of the pump and the accuracy and flow rate of the infusion,
and may generate hazardous fluid pressures which may activate occlusion alarms at
unpredictable pressures.

The Q Core Medical Ltd. warranty on this device will be null and void and Q Core
Medical Ltd. will assume no responsibility for incidents which may occur if the product
is not used in accordance with product labeling. Refer to Warnings and Safety
Precautions on page 19 for a complete list of warnings and cautions.

Technical Assistance
For technical questions, troubleshooting assistance and device problems, please

contact your local agent/distributor. You may also contact Q Core Medical Ltd. support
via email to the following address: support@Qcore.com
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Chapter 1: Introduction

The following sections describe the functions and features of the [VVet pump, and
provide a summary of safety and regulatory information:
Product Overview and INdications .........cccccceciiieiiiiciiie e
Terms and ADDBreviations .........ccoieereririnienenieene ettt
Document ConVeNntions ........cccciiiiiiiiiiiiiiii e
Safety and Compliance Information
Warnings and Safety Precautions .........ccooeiiiieiieiiieeeceecee e

Product Overview and Indications

The Q Core IVVet infusion pump is intended for veterinary only controlled delivery
through intravascular, subcutaneous,and intra-arterial routes. The pump is designed to
deliver saline, Total Parenteral Nutrition (TPN), lipids, IV medication, blood and blood
products.

The IVVet pump includes the following infusion modes for all intended uses:
Continuous and Multi-step.

The pump is intended to be used by licensed health care professionals in a clinical
environment.

The dedicated Q Core administration sets for the IVVet pump are intended for
single-veterinary patient use and single-use only.

This user manual supports the use of IVVet software version r13. Verify that the software
version that appears on the [VVet turn-on screen is r13. The version number can be
viewed from View system as well (for more information, refer to View Menu on

page 97).
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Features

The features of the [VVet pump are designed to simplify treatment and ensure patient
safety.

Treatment-Related Features

Single platform device: The delivery mode of the pump can be changed,
according to the required type of infusion.

Priming alternatives: Both manual priming (by gravity) and automatic priming
(using the pump) are available.

Quick infusion titration (in most delivery modes): Modification options allow
updating of infusion parameters without stopping the infusion.

Delayed Infusion: Allows users to program an infusion in advance, and set it to
Standby for an unlimited time period, or to set it for a defined Delayed Period.

Repeat Last Infusion: Automatically saves the parameters of the last infusion, and
allows a quick-start infusion using these parameters.

Resume Infusion After Pump Shut Down: Allows resuming an infusion after the
pump has been shut down from a running or paused infusion.

PreSet Programs: Allows saving the infusion parameters of commonly used
protocols, and allows a quick-start infusion using these parameters.

Piggyback (Continuous delivery mode only): Provides the ability to add a
Secondary line to a running continuous infusion, without re-entering infusion
parameters for the Primary line.

Safety-Related Features

Lock Screen: Avoids inadvertently activating screen functions by locking the
screen when the infusion is running.

Authorization lock level: Allows access to only those pump functions for which
the user has authorization. Authorization levels (High and Technician) are
password-controlled.
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® Range parameter safety check: Prevents entering infusion parameters that are
outside of a precalculated safety range. The permitted ranges vary according to
the parameters already entered by the user, or by the limits defined in the Drug
Library, if one is installed on the pump.

®  Easy alarm troubleshooting: Alarm screens display specific instructions about
how to manage the alarm or resolve the problem.
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Terms and Abbreviations

The following table defines common terms and abbreviations used in this manual.

Term/Abbreviation

AFFV
AC/DC
Accum.
DFU
ECG
EMC
EMI

H

Kg
KVO
MAC
mcg
mEg
min

mg

mL
mmol
MRI
mUnits
M Units
nanog
Occ.
PHY

1

Meaning

Anti-Free-Flow-Valve

Alternating Current / Direct Current

Accumulated
Directions for Use

Electrocardiogram

Electromagnetic compatibility

Electromagnetic interference

Hour

Kilograms

Keep Vein Open
Media Access Control
Micrograms
Milliequivalents
Minutes

Milligrams

Milliliters

Millimoles

Magnetic Resonance Imaging

Milliunits
Million Units
Nanograms
Occlusion

Physical Layer
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Term/Abbreviation Meaning

Prim. Primary

RF Radio Frequency

Sec. Secondary

VI Volume Infused

VTBI Volume To Be Infused
Q Core Q Core Medical Ltd.
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Document Conventions

The following messages in this manual prompt readers to pay special attention to
specific points:

g Warnings indicate precautions and instructions which, if not
followed, may result in personal injury.

Cautions indicate instructions which, if not followed, may result in
J s damage to the equipment or to the quality of treatment.

0 Notes provide additional information to help obtain optimal
equipment performance.

The parameters ranges described in this manual reflect their factory default settings.
These ranges may be configured by an authorized technician.

Safety and Compliance Information

The following section presents important labeling, safety and compliance information:
®  Symbols and Labeling on page 14

®  Compliance and Classification on page 17

®  Biocompatibility on page 17

®  Sterilization on page 18

® Degree of Protection Against Ingress of Water and Dust on page 18
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Symbols and Labeling

The following table describes the labels and symbols that appear on the [VVet pumps
and their components, and identifies their locations on the equipment.

Symbol Description Location

Back of the pump casing and
SN Serial number. on the back of the mini

cradle.

Back of the pump casing and
REF Catalog Number. on the back of the mini
cradle.

Batch code. Inside casing of the mini

LOT cradle.

Caution: Consult accompanying

documents for safety instructions (service Back of the pump casing
to be performed by qualified technician; cover and on the back of the
consult Service Manual before removing mini cradle.
cover).
Jf Storage temperature range. Shipping package.
% Storage humidity range. Shipping package.

e

g Storage atmospheric pressure range. Shipping package.
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Symbol Description

Consult instructions for use.

Follow instructions for use.

Q =

The C and US indicators adjacent to the

CSA mark signify that the product has

® been evaluated to the applicable CSA and
UL standards, for use in Canada and the

US United States.

&

C

Date of manufacture (year).

Name of manufacturer.

E

Identify defibrillation proof and degree of
|_ protection against electric shock.
Equipment Type BF Applied Part.

Input: 100-240 V; 50-60 Hz; Max. 120 VA
Output: 10V DC; Max. 4.7 A.

N>

P24 Dust and splash proof.

Location

On the back of the mini
cradle.

Back of the pump casing.

Back of the pump casing.

Back of the pump casing.

Back of the pump casing and
on the back of the mini
cradle.

Back of the pump casing.

Bottom of the cradle (which
houses the AC/ DC adaptor).

Back of the pump casing.
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Symbol Description

Rx Only US federal law restricts this device to
prescription only.

Waste Electrical and Electronic Equipment
(WEEE) Disposal.

This symbol indicates that used batteries
and electronic equipment must not be
disposed of as unsorted municipal waste,
and must be collected separately. Contact
an authorized representative for
information concerning the
decommissioning of your equipment.

ALARM Alarm — LED, when lit, indicates an alarm
situation in the operation of the pump.
Refer to Hardware and Software
Components on page 26.

CHARGE Charge — LED, when lit, indicates that the
battery is charging. Refer to Hardware
and Software Components on
page 26.

RUN Run — LED, when lit, indicates that the
pump is infusing. Refer to Hardware and
Software Components on page 26.

STOP Stop — Allows you to temporarily stop the
infusion.
On/Off On/Off — Turns pump On and Off.

Introduction

Location

Back of the pump casing and
on the back of the mini
cradle.

Back of the pump casing
cover, and on the back of the
mini cradle.

Front casing of the pump,
below the red LED.

Front casing of the pump,
below the yellow LED.

Front casing of the pump,
below the green LED.

Front casing of the pump,
below the touch screen.

Front casing of the pump,
below the touch screen.



Compliance and Classification

This manual has been written in conjunction with the requirements in the International
Standard, IEC 60601-2-24 for Medical Electrical Equipment - Part 2-24: Particular
Requirements for Safety of Infusion Pumps and Controllers. Data presented in the
Technical Specification section reflect specific test conditions defined in this standard.
Other external factors, such as varying back pressure, temperature, head height, set
usage, fluid restrictions, solution viscosity, or combinations of these factors may result
in deviations from the performance data presented.

e |EC 60601-1, UL 60601-1 and CAN/CSA C22.2 601.1-M90 medical electrical
equipment, which classifies the IVVet pump as:

Class I

Type BF

Continuous operation

IP24 dust and splash proof

Not suitable for use in the presence of flammable anesthetic mixture with air or

with oxygen or nitrous oxide

® |EC 60601-1-2: Electromagnetic compatibility.

e |EC 60601-2-24: Infusion pumps and controllers, which classifies the IVVet pump
as a Type 4 pump (continuous infusion flow, combined with bolus delivery).

® |EC 60601-1-11: Requirements for medical electrical equipment and medical
electrical systems used in the home healthcare environment.

® |EC 60601-1-8: Requirements for alarm systems in medical electrical equipment
and medical electrical systems.

®  Defibrillator compliance statement: Equipment Type BF Applied Part.

Biocompatibility
All materials in components of the administration sets that are in the fluid pathway have

been tested for biocompatibility, and are in compliance with applicable international
standards I1SO 10993-1 for biocompatibility.
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Sterilization

Administration sets that are manufactured by Q Core for the IVVet pump, are sterilized
with ethylene oxide (EO), according to the sterilization requirements of ISO 11135-1.

Degree of Protection Against Ingress of Water and Dust

The IVVet pump meets the IP24 splash/dust standard according to IEC 60601-1-11.
Protects from water which is sprayed at 10 L/min at a pressure of 80-100 kN/m2 for

5 minutes at all angles, and protects from touch by objects greater than 12 millimeters
such as fingers.
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Warnings and Safety Precautions

The following sections contain important safety information.
All warnings and safety precautions should be read carefully before operating the [VVet
pump:

® General Warnings and Precautions on page 19

® Proper Use of the Pump on page 23
Safety information specific to particular pump functions appears in the relevant
sections of this manual.

General Warnings and Precautions

To ensure safety and proper operation, read the User Manual and any instructions
accompanying disposables or accessories before operating this device. In addition,
adhere to the following safety guidelines:

Avoid placing the administration set or power cord on the floor, or
A any other location where it can accidentally be damaged or provide
a risk of strangulation, particularly due to excessive length.

®  To avoid damage to the pump and its accessories, keep the equipment away from
unattended children and pets.

® Do not clean, disinfect or sterilize any part of the pump by autoclaving, or with
ethylene oxide gas. Doing so may damage the pump and void the warranty. Only
external parts of the pump should be disinfected.

If the pump is dropped or appears to be damaged, it should be
A taken out of service and inspected by Q Core Medical Ltd. trained,
qualified personnel only.

®  All service procedures, including certification, calibration, part replacement and
modification of equipment, should be carried out only by a qualified service
technician. Detailed instructions are available in the service manual.

® Do not operate the pump with the safety door open.
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Waste Disposal

Take care to dispose of the packaging, the administration sets, the battery, and any
other electronic components in accordance with applicable environmental laws (such as
the WEEE Directive for Waste Electrical and Electronic Equipment). Contact your local
authority to determine the proper method of disposal.

A Waste Disposal Safety Precautions

®  Keep used plastic infusion containers, packaging and tubing out of the reach of
children.

®  Administration sets should be disposed of in a proper manner, considering the
nature of residual fluid that may be contained within, in accordance with hospital
disposal practices.

® Do not dispose of the battery in or near fire.

Explosion Hazard

The equipment is not suitable for use in the presence of flammable anesthetic mixture
with air or with oxygen or nitrous oxide.

Electric Shock Hazards
To promote safety, always adhere to the warnings listed below.

A Electrical Safety Precautions

®  Access to any internal part of the [VVet pump and the performance of any service
procedures should be carried out only by a qualified service technician, fully
trained in the operation of the infusion pump.

®  Disconnect the power supply before servicing.

® Disconnect the battery prior to opening the pump casing. Voltage present on
internal components may cause severe shock or death on contact.

®  Connect AC power to the pump only via a Q Core supplied power adapter.
® Do not touch the pump to cradle (P2C) connection in the back on the pump.
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Electromagnetic Compatibility

The IVVet pump is designed to conform with electromagnetic compatibility (EMC)
standard IEC 60601-1-2 and to operate accurately in conjunction with other medical
equipment which also meets the requirements of this standard. To avoid
electromagnetic interference that may affect the operation of the pump, do not use the
pump near sources of strong electric and magnetic interference (EMI), such as large
electric motors.

®  Manage the electromagnetic environment to permit the device to perform as
intended without disturbing other equipment.

®  Separate the device from all other electronic equipment. If the device must be
used near other electrical equipment, monitor the equipment to ensure there is no
electromagnetic interference.

®  Devices should not be used adjacent to or stacked with other equipment. If the
device must be used adjacent to or stacked with other equipment, monitor the
device to verify normal operation.

®  If you suspect external RF sources or other equipment are influencing device
operation, contact the biomedical engineering department for additional
guidelines concerning electromagnetic immunity.

® Contact the biomedical engineering department for additional information in the
service manual concerning operating devices near RF sources.
The EMC limits for the Medical Device Directive 93/42/EEC (EN301489-1/-17 IEC/EN
60601-1-2:2007) are designed to provide reasonable protection against harmful
interference in a typical medical installation. The equipment generates uses and can
radiate radio frequency energy, and if not installed and used in accordance with the
instructions, may cause harmful interference to other devices in the vicinity. However,
there is no guarantee that interference will not occur in a particular installation. If this
equipment does cause harmful interference with other devices, which can be
determined by turning the equipment Off and On, the user is encouraged to try to
correct the interference by one or more of the following measures:

®  Reorient or relocate the receiving device

® Increase the distance separating between the equipment parts
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®  Connect the equipment to an outlet on a circuit different from that to which the
other device(s) is connected

®  Consult the manufacturer or field service technician for help

Portable and mobile RF communications equipment, such as cellular telephones, 2-way
radios, Bluetooth™ devices, microwave ovens in close proximity to this device may
affect wireless communications with the Infusion pump and/or the operation of the
Infusion pump. Special precautions need to be exercised regarding EMC. These
include:

®  Maintaining a minimum separation distance of 2 ¥z ft (% m) between the Infusion
pump system and portable/mobile RF communications equipment

Electromagnetic Safety Precautions

® Do not expose the pump to therapeutic levels of ionizing radiation, as permanent
damage to the pump electronic circuitry may occur. It is preferable to remove the
pump from the patient during therapeutic radiation sessions.

® Do not use the pump in the vicinity of magnetic resonance imaging (MRI)
equipment, as magnetic fields may adversely affect the operation of the pump.
Remove the pump from the patient during MRI procedures, and keep it at a safe
distance from magnetic energy.
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Proper Use of the Pump

Although the IVVet pump has been designed and manufactured to exacting
specifications, it is not intended to replace trained personnel in the monitoring of
infusions.

Clinicians are advised to verify the proper route of delivery, and the
A patency of the infusion site.

When using the pump, periodic patient monitoring must be performed to ensure that
the infusion is proceeding as expected. The pump is capable of developing positive
fluid pressures to overcome widely varying resistances to flow, such as resistance
imposed by small-gauge catheters, ports, filters, or intra-arterial infusions. Although the
pump is designed to stop fluid flow when an alarm occurs, it is neither designed nor
intended to detect infiltrations or extravasations, and such conditions will not trigger an
alarm.

When using the pump, use only Q Core approved accessory
A equipment.
If auditory and/or visual signals do not perform according to
A settings, or if the hard keys do not perform as expected, do not use

the pump, and contact an authorized technician.

Environmental Safety Precautions

®  The pump has not been evaluated for use within magnetic resonance imaging
(MRI) environments, or with other medical equipment that emits radiation for
diagnostic or therapeutic purposes.

®  The Vet pump has not been evaluated for compatibility with Extracorporeal
Membrane Oxygenation (ECMO) systems.

®  Use only Q Core supplied accessories and cables. The use of accessories and
cables other than those specified in this manual, with the exception of cables sold
by Q Core Medical Ltd. as replacement parts for internal components, may result
in increased emissions or decreased immunity of the pump.

23 Vet Infusion Pump User Manual



Administration Sets

Before using administration sets, always read and follow the instructions in the User
Manual, and the instructions accompanying the administration set and source
container. Carefully follow any label copy instructions for loading, removing, and
reloading the set, as well as the recommended set change interval.

Use only valid Q Core supplied administration sets with the [VVet
A pump. Severe injury or death may result from using sets other than
those indicated in Q Core's approved list of products.

For infection control purposes, consider the set change interval recommended by the
local Centers for Disease Control and Prevention (CDC), your facility guidelines, and
the instructions provided with the administration set.

A Administration Sets: Safety Precautions

® Do not use a damaged administration set or damaged set components or
packaging. Always refer to the instructions for use that are included.

®  Q Core administration sets are for single patient use only, and should not be
sterilized or cleaned for re-use.

® Do not connect the administration set to the patient while priming.
® Do not use force when connecting the administration set to the patient.

®  Always use the clamps on the administration set to occlude the administration set
prior to removing the Q Core administration cassette from the pump.

® Do not apply pressure or pressurized air to any outlet or tubing connected to the
pump. Pressure may destroy sensitive elements.

® Do not pull or stretch the tubing in any section of the administration set when the
pump is in use, nor apply pressure to the infusion container.

0 The minimum pull force applied on the administration set which is
capable of disengaging the administration set from the pump is
2.855 Kg.

®  The administration set and container should be replaced as needed to avoid fluid
contamination problems.
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®  The administration set must be replaced according to the hospital policy of
infection control and treatment protocol. Q Core sets allow accurate delivery up to
96 hours. If you program rate, dose or bolus combinations which exceed a
96-hour schedule, make sure that you replace the administration set on time.

Basic Infusion Safety Information

To obtain maximum accuracy of the pump when used in a hospital or clinical
environment, verify that the infusion container is positioned at a height of 50 cm above
the pump. There is no restriction on the location of the infusion container in relation to
the patient’s heart.

Alarm conditions automatically stop the infusion and require immediate attention
before the infusion can be restarted.

A Administering Infusions: General Safety Precautions

®  Occlusion Pressure Alarm Settings:

High pressure settings may affect the time for occlusion detection. Make sure
that the occlusion pressure is set according to the clinical use case.

®  Volume To Be Infused: Do not enter a volume to be infused greater than the
amount of fluid available in the container.

® Secondary Infusions: When using the Piggyback infusion feature, verify that:

25

The medication/solution in the Secondary infusion container is compatible
with the medication/solution in the Primary infusion container.

The Secondary administration set is connected to the appropriate injection site
on the primary administration set (above the administration cassette).
Interruption of the Primary infusion is clinically appropriate for the duration of
the Piggyback infusion.

The Secondary source container is positioned at least 8 inches (20 cm) higher
than the Primary source fluid level.

The drip chamber on the set should be used to verify that the correct line is
delivering and the other line is idle.

The clamp of the Secondary set is closed when Piggyback infusions are not
running.
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Chapter 2: Components, Accessories,

and Administration Sets

The following sections present a high level overview of the [VVet pump components
and accessories:

Unpacking the PUMP .ceciiiiiicicicicce et 26
Hardware and Software ComMpPoNnents .........cocceirirerenineneniereeereeereeeeeneenes 26
UsiNg PUMP ACCESSOTIES ...oouviiiiiiiiiiiiiiiiciici e 29

Unpacking the Pump

When unpacking the [VVet pump, inspect each item to ensure that it is undamaged.
The following items should be included:

®  IVVet pump (with Li-lon Battery enclosed)

® AC/DC power adaptor for pump

®  User Manual

®  Mini cradle, with key (to lock) and pin (to allow open/close without the key)
®  Other optional items:

® Splitter for mini cradle
® Communication cable

Hardware and Software Components

The pump includes both hardware (control unit) and software (touch screen)
components. Hardware components are shown in the figure below. The parts of the
control unit are listed and described in the table following the figure.
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Figure 2.1.

Number
1

N/A

27

Hardware Components

1

Component Description/Notes

Safety door Covers and protects the administration set and pumping
mechanism.

Speaker Delivers auditory alarm sounds.

Status LEDs Colored indicators providing a summary of the pump

current status:

® Red: An alarm is occurring.

® Yellow (blinking): The battery is charging.

® Yellow (steady on): The pump is connected to main
power, and the battery is fully charged.

® Green: The pump is running.

On/Off button Enables the user to turn the pump On and Off.

Stop button Enables the user to temporarily stop an infusion.

Power socket Enables you to charge the battery using the power
adaptor, connect a communication cable or a bolus
handle.

Battery Houses the battery. (Located on the back of the pump.)

compartment
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Touch Screen

The touch screen is used to configure and operate the pump. The main areas of the
screen are listed and described in the table following the figure.

Figure 2.2. Touch Screen Areas
1 Running g Continuous i)
| ¢100
E:,I: Rate »

= 499 viel >
M 1/500 VI f Total

mLfml

- () 04:59:24  Time left >

hminsec

View/Edit

Number Component Description/Notes
1 Indicators Bar Displays the following essential status information:
® Screen title (Start Up, Running, Paused, etc.).
® Running icon (appears while an infusion is running).
® Delivery mode (Continuous, Multi-step).
® Battery status icon.
2 Main Display Displays infusion parameters and other pump settings,

and serves as a work area in which most programming
and configuration takes place.

3 Toolbar Contains function keys that enable you to perform
common operations, such as confirming settings,
pausing infusions, locking the screen, etc.
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Using Pump Accessories
This section explains how to set up the following pump accessories:
Mini Cradle ..o

Power Supply ............
Administration Sets

Mini Cradle

The small, easy to use bedside mini cradle offers flexible positioning of the pump at
any angle or height. Components of the mini cradle are listed and described in the
table following the figure.

Figure 2.3. Mini cradle
1

«— 3

Number Component Name Description/Notes

1 Pump hook Located on the pump holder. Press the hook to
release the pump from the mini cradle.

2 Mini cradle knob Located on the base of the mini cradle. Twist the
knob to connect or release the mini cradle from an
IV pole. To unlock the knob, use the supplied key

or pin.
3 Connection splitter Located on the base of the mini cradle. Used for
(optional) the RS-232 communication cable (optional) and

power-supply connections.

29 Vet Infusion Pump User Manual



To operate the pump from an IV pole set, attach the pump to the mini cradle. This
enables easy access to the screen without the risk of changing the settings through
accidental contact. In the mini cradle, you can also charge the pump.

y Make sure the cradle is securely attached to the IV pole before
y .\ attaching the pump.

The following steps explain the workflow of attaching the mini cradle to the IV pole,
attaching and releasing the pump, and releasing the mini cradle from the pole:

1. Attach the mini cradle to the IV pole by tightening the mini cradle knob on the
right side (Figure 2.3, #2).
To unlock the knob, make sure that the supplied key or pin is placed inside it.

To attach several pumps to the IV pole, rotate the mini cradle to a
o horizontal position:
Pull the pump holder and the base of the mini cradle away from
each other, and rotate to the desired position.

2. To attach the pump to the mini cradle, insert the pump onto the bottom hooks of
the mini cradle (Figure 2.4, #1), and then click it into the top hook (Figure 2.4, #2).

3. Torelease the pump, press the pump hook located on the top of the pump holder
(Figure 2.4, #2).

4. To open and release the mini cradle, rotate the knob.

Figure 2.4. Mini cradle Hooks
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Power Supply

The pump power supply is used to charge the battery. Specifications of the power
supply include:

® Input voltage: 100-240 VAC
®  Output voltage: 10 VDC

A To prevent entanglement, always secure the cable cord properly.

> To charge the battery:

1. Plug the Q Core supplied power supply cord into the main power supply source.

2. With the white arrows facing up, plug the power cord into the IVVet pump power
socket or into the splitter connector.

3. On the front of the pump, verify that the Charge LED status indicator is On
(blinking yellow light).

For more information regarding charging the battery, refer to Charging the Battery on

page 134.

> To disconnect the power supply from the pump:

Gently press on both sides of the power supply connector, and pull it out of the [VVet
pump power socket.
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Administration Sets

The IVVet pump should be used with a Q Core approved administration set, which
includes the Q Core administration cassette. This cassette includes a normally closed
valve (three-state Anti-Free-Flow Valve) that provides automatic anti-free-flow
protection. Opening the valve allows manual priming as well as transition of infusion to
gravity induced.

Figure 2.5. Q Core Administration Cassette and AFFV

For more information about priming the administration set and inserting it into the
pump, refer to Priming Manually on page 53 and Inserting the Administration
Cassette on page 49.
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Q Core Approved Administration Sets

This section provides a list of administration sets approved by Q Core Medical Ltd. to
be used with the IVVet pump.

Use only Q Core standard administration sets listed here or in
A Q Core's approved list of products:
http://www.qgcore.com/
Using anything other than Q core administration sets with the pump
may result in operation that is not within the constraints and
parameters of the device.

Name of Set Part Number

VT101 blood set with non-vented spike, 200?m filterand ~ 12006-000-0004
needleless Y-Site

VT406 Infusion set with vented/non-vented drip 12000-000-0023
chamber and needle Y-site

VT409 Primary infusion set with vented/non-vented drip 12005-000-0005
chamber, back check valve and 2 needleless y-site

VT410 Secondary Infusion set with vented/non-vented 12005-000-0006
drip chamber

Other products available from Q Core Medical Ltd. are listed in Q Core Official Product
List, at http://www.qcore.com
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Chapter 3: Fundamental Concepts and

Operations

The following sections explain the structure and function of the Main Display and the
toolbar, provide an overview of the delivery modes, and describe special features that
can be enabled and disabled, according to user requirements:

Working with the Main Display ........cccocoviiiiiiiiiiiiicccccce, 34
Selecting Delivery Mode ........ccciiiiiiiiiiiiieiicic e 38
Enabling Special Features ..o 40

Working with the Main Display

The Main Display is a touch screen that serves as a work area for programming infusion
parameters, and choosing from lists of possible selections. While an infusion is running,
selected infusion parameters and other relevant information (such as time left until
completion of the infusion) appear on the Main Display.

The following sections describe how to use the keypads, and provide an overview of
the main function keys and icons that appear on the Main Display.

Using the Keypad

Numeric keypad

The keypad is used for entering digits, and to specify parameters for volumes, rates
and times. As you press the relevant digits, they are displayed in the frame at the top of
the Main Display, replacing the name of the parameter. Pressing Clr, at the lower left
corner of the keypad, clears all entered digits and lets you re-enter the value.
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Rate P Continuous iiii]
3
1 2 3
4 5 6
7 8 9
G o

The acceptable range of a given parameter is displayed in the upper right corner of the
Main Display. When you enter a value that is outside of a permitted range, the range
values stay red, and the OK function key is disabled. The values of a range are
dynamic, and change according to other parameters that have already been
programmed.

When entering time, the pump allows you to enter minutes up to the value of 59.
Infusion time of over 59 minutes must be expressed in hours and minutes. For example,
90 minutes must be entered as 1:30 (h:min).

Alphanumeric keypad

In some instances, for example, defining a new PreSet program, entering a patient ID
or entering a drug name, the keypad displays letters and symbols in addition to
numbers.

The Alphanumeric keypad displays uppercase letters with numbers, and lowercase
letters with symbols. Uppercase letters and numbers are the default state. Switch the
default keypad from uppercase and numbers to lowercase and symbols by pressing the
‘abc sym' key on the toolbar and back to default by pressing 'ABC 123" key.
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Overview of Toolbar Function Keys

The function keys are located in the toolbar, and enable user actions. The function keys
that appear vary according to the screen or program that is currently selected.

Function keys enabling basic actions are described in the following table.

Name of Key Action Notes
oK Confirms a selection or an If the selection involves parameters
entered parameter that are out of the permitted range,
the OK key is disabled.
Prime Initiates priming Appears in the Attention screen, after
the Prime function has been selected.
Mute/Unmute Silences/unsilences the Appears when any alarm is triggered.
speaker The speaker unmutes automatically
after 2 minutes.
Back Displays the previous screen
Exit Returns to either the StartUp In situations when the Back key and
screen, or to the screen the Exit key will take users to the
displaying current infusion same screen, only the Exit key is
parameters displayed.

The following function keys are available from the Running screen:

Name of Key Action Notes

Lock Locks the screen or the For more information, refer to
pump Locking the Screen on page 83.

Press to Unlock Unlocks the screen

screen
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Name of Key Action Notes

Request Pause/ Pauses an infusion or a bolus ~ For more information, refer to
Pause Bolus Pausing Infusions on page 81.
Request Continue/ Resumes a paused infusion
Continue Bolus or a bolus
View/Edit Displays a list of infusion

parameters to be viewed or

edited
Bolus Delivers a bolus during

continuous mode

Overview of Icons

Icons that frequently appear on the Indicators Bar and the Main Display are described
in the following table. In addition, some alarms appear with their own icons.

Icon Meaning Notes

> Indicates that the parameter To initiate the update, touch the
immediately adjacent to the icon canbe  box in which the icon appears.
viewed and updated directly from the
Main Display.

a Rate of the infusion.

Volume to be infused.

4 < Time remaining until the end of the
infusion.
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Meaning Notes

Indicates that an infusion is currently
running.

For more information, refer to

Wi Indicates status of battery charge. Battery Care Information on
page 131.

Selecting Delivery Mode

The IVVet pump is a multi-platform device that has the ability to operate in several
different delivery modes.

0 The delivery modes availability can be set by a technician

Possible delivery modes include:

Mode Description/Notes

Continuous Delivers an infusion at a constant, programmed rate. This
mode includes the option to add a Secondary (Piggyback)
line.

Multi-step Delivers the infusion in a set of 1 and up to 25 steps.

Each delivery mode features its own unique options. The current mode is displayed at
the right side of the Indicators Bar on some of the screens. On screens that are not
mode related, such as Delivery mode selections screen below, the name "IVVet" is
displayed instead.
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Figure 3.1. Indicators Bar: Delivery Mode

Delivery mode | VET  [assas]

Continuous Multi-step

Changing the delivery mode is done using the Options menu. An authorization code of
High is required to modify the delivery mode. For more information about how to
change the delivery mode, refer to Setting Delivery Mode on page 87.
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Enabling Special Features

Depending on the needs of a specific clinical care area or institution, the [VVet pump
can be enabled to perform special functions. An authorization code is required to
enable/disable these functions.

0 All local changes made to any configuration will remain valid until
reconfigured or until the pump is set to factory defaults.

The following features can be enabled/disabled by users who have an authorization
code of High:

Delivery
Feature Mode(s) Description/Notes
Allow delayed All Enables users to start an infusion at a later time. The
start user may either define a specific delay period or set the

pump to Standby.
For more information, refer to Using the Set Delay
Feature on page 107.

Allow All Allows users to start an infusion using predefined

PreProgram infusion parameters. When this option is enabled, the
PreSet Programs button appears on the pump Start Up
screen.

For more information, refer to Creating and Editing
PreSet Programs on page 104.

Prime Reminder Al Enables a reminder for the user to prime the
administration set before starting an infusion.
For more information, refer to Automatic Priming
Using the Pump on page 51
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Delivery

Feature Mode(s) Description/Notes

Advanced Bolus ~ Continuous Allows users to program a bolus by entering rate,
amount and time.
For more information, refer to Administering a
Bolus on page 64.

Screen Saver All Provides a distant view of the main parameters during a
running infusion. Activated 30 seconds after the
infusion starts.

A Technician authorization code is required to enable/disable the following additional
features:

Delivery

Feature Mode(s) Description/Notes

Delivery modes All Determines the available delivery modes. Each mode
can be turned Off separately.

New Patient All Allows users to associate an infusion with patient
identification parameters, and reset the Accumulated
VI (accumulated volume infused).

Set Secondary Continuous Allows users to program a Secondary infusion.

(Piggyback) For more information about programming a Secondary
infusion, refer to Adding a Secondary Line on
page 68.

Allow Bolus Continuous Allows users to program a bolus during a Continuous

infusion. When this feature is enabled, the Bolus
button appears in the toolbar during the running
infusion. For more information about administering a
bolus, refer to Administering a Bolus on page 64.

Bolus Rate Continuous Specifies the rate of delivery of a fast dose, for rapid
volume infusion.

Sec. Bolus Rate Continuous Specifies the rate of delivery of a fast dose for a
Secondary (Piggyback) infusion.
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Delivery

Feature Mode(s) Description/Notes

Occ. All Enables the pump to automatically restart an infusion,

Auto-restart up to 5 times an hour, if a downstream occlusion was
detected and cleared within 40 seconds.

mL/h Only All Allows users to use units other than mL/h. If this option
is enabled, programming will automatically default to
mL/h.

Setting KVO rate

Allows users to set the default rate of fluid that is delivered when the infusion program
is completed. The permitted range for the KVO rate parameter is 0-20 mL/h (for all
delivery modes).
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Chapter 4: Getting Started

The following sections explain the sequence of actions necessary to prepare the pump
and the administration set for an infusion:

Typical Workflow ..o 44

Connecting the Infusion Container to the Administration Set ........cccocceeereennens 47

Opening the Safety DOOr ..o 48

Inserting the Administration Cassette ......ccovveoiriereiieneie e 49

Automatic Priming Using the PUmMpP ..o 51
Typical Workflow

The recommended workflow for preparing the pump and administration set for an
infusion comprises the following steps:

1. Turn the pump On.
Connect the infusion container to the administration set.
Open the safety door.

Insert the cassette.

Prime the administration set using the pump.*

ok W

Connect the administration set to the patient. When using an administration set
with a filter, place the filter under the patient’s IV infusion site.

The workflow sequence is illustrated in the following figure:

* |t is recommended to prime the administration set using the pump. It is possible to

K)Arime the administration set manually. For more information, refer to Priming
anually on page 53.
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Figure 4.1.
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Recommended Workflow
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Turning the Pump On

The pump is turned On by pressing the On/Off hard key, at the lower right corner of
the pump.

While the pump turns On, a system check is performed. If you do
not hear a sound from the speaker, or if items on the screen do not
display properly, do not use the pump.

0 If a message regarding resuming previous infusion appears upon
turning the pump On, refer to Resuming Infusions After Pump
Shutdown on page 80.

Turning the Pump Off

Pressing the On/Off hard key for 5 consecutive seconds turns the pump Off.

Alternatively, press the On/Off hard key, and then, from the Attention screen, press
Off.

0 After operating the pump with <1 mL/h flow rate, you will be
prompted to remove the administration cassette before turning Off
the pump.

For more information about turning the pump Off during an infusion, refer to Aborting
Infusions on page 82.
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The pump enables resuming an infusion after pump shut down. For more information,
refer to Resuming Infusions After Pump Shutdown on page 80.

Connecting the Infusion Container to the
Administration Set

This section explains how to connect the infusion container to the administration set.

Before setting up the infusion, verify that the container,
A administration set and administration set package are undamaged.

> To connect the container to the administration set:
1. Open the sterilized administration set package.

2. Close the clamps and the AFFV to block the administration set. Make sure that the
clamp is located at least 20 cm from the pump.

3. Spike the administration set into the container.

0 Verify that the arrow on the administration cassette is pointing
toward the same direction of the fluid flow (down).

A Connecting the Infusion Container: Safety Precautions

®  Make sure there is no leakage from the container, and that the spike is firmly
attached to the container.

®  \Verify that the set components are positioned correctly. The arrows on the
administration cassette and the filter must point toward the direction of the flow
(from the container to the patient).

®  When using a filter, maintain the filter level below the vascular access site.
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Opening the Safety Door

Opening the safety door involves pressing it down while simultaneously pulling the
safety door open.

> To open the safety door:

1. Using your thumb, press the door outwards.
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Inserting the Administration Cassette

Inserting the administration cassette into the pump involves positioning the cassette in
the proper direction, and ensuring that all portions of the cassette including the flange,
are secured inside the administration cassette’s housing. In Figure 4.2, the flange is
represented by #2, and the saddle is represented by #1.

Figure 4.2. Administration Cassette

/ It is recommended to make sure that the pump is turned On, and to
verify that all clamps on the administration set are closed before
inserting the administration cassette.

> To insert the Q Core administration cassette:

1. Open the safety door (Opening the Safety Door on page 48). Then, insert the
administration cassette at an angle, by placing the saddle (Figure 4.3, #1) on the
round metal anchor (#2) in the cassette's housing. Make sure that the arrow on the
cassette (#3) is pointing toward the bottom of the pump, and the bottom flange is
inside the cassette housing.
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Figure 4.3. Insertion of Cassette

2. Clip the upper end of the administration cassette into the metal lock (Figure 4.3,
#4).

3. Close the safety door over the administration cassette. Ensure that the safety door
clicks upon closure.

Removing the Administration Cassette

When the infusion is complete, close the clamps, disconnect the administration set
from the patient, and disconnect the administration cassette.

In case of emergency, you can stop pump operation by opening the safety door,

closing the clamps, removing the administration cassette from the pump and
disconnecting the administration set from the patient.
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The following procedure describes how to remove the cassette from the pump.

Although the AFFV offers automatic free flow protection, a small

A amount of fluid (up to 0.09 mL) may be expelled when the
administration cassette is detached. In order to ensure full
protection, disconnect the patient from the administration set
before detaching the cassette from the pump.

> To remove the Q Core administration cassette:

1. Close all clamps on the administration set.

2. Disconnect the patient from the administration set.

3. Open the safety door (Opening the Safety Door on page 48).
4

Loosen the cassette by raising the metal lock that secures it to the pump (#4 in
Figure 4.3).

5. Pull out the cassette, and close the safety door.

Automatic Priming Using the Pump

Before commencing infusion setup, the administration set needs to be primed. Priming
expels all the air from the administration set, and fills it with the infusion liquid. A fully
primed administration set is a set filled with infusion liquid (from which all the air was
removed).

0 It is recommended to prime the administration set using the pump.

Priming with the pump can be initiated from the following screens:
® StartUp

®  Start

®  Paused (infusion or bolus)

®  Ajrin Line Alarm
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Before using the pump for priming, ensure that:

®  The administration set clamp is open.

®  The safety door is closed.

The Q Core administration cassette is properly connected to the pump.

A

Before priming, verify that the administration set is disconnected
from the patient.

When the Prime Reminder is enabled and the set has not yet been
primed using the pump, a Prime Reminder will be displayed,
enabling the user to press Prime in order to start priming or to
press Start in order to proceed with the infusion (refer to
Configuring General Settings, page 93).

> To prime the administration using the pump:

1. Position the pump in an upright position using one of the following methods:
® Attach the pump to the cradle base.
® Attach the pump to an IV pole using the mini cradle.

2. From the toolbar of the Start Up, Start, Air in Line Alarm, or Paused screen, press

Prime.

3. Verify that the administration set is disconnected from the patient. Then, from
the Attention screen, press Prime. Priming begins.

While the pump is priming, a progress circle appears on the screen, with a time
countdown displayed. The default priming time is 2 minutes.

When using administration sets that contain less than 20 mL, shorter priming times
can be set. For more information, refer to Set prime volume on page 92.

A

During priming with the pump, the Air in line alarm is disabled.
When priming, check that all clamps are opened and that there is no
occlusion. Ensure that liquid, not air, enters the administration set
during priming.
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The pump automatically indicates when priming is finished.
If priming is completed before the default priming time has elapsed, automatic
priming can be discontinued.

> To discontinue priming:

1. From the toolbar, press Finish Prime. Alternatively, at the bottom of the pump,
press the Stop hard key.

2.  From the toolbar, press OK

Priming Manually

The Q Core administration set can also be used as a gravity set, and the Anti-Free-Flow
Valve (AFFV) can be used manually.

Before commencing infusion setup, the administration set needs to be primed. Priming
expels all the air from the administration set, and fills it with the infusion liquid. A fully

primed set is a set filled with infusion liquid (from which all the air was removed).

The following procedure explains how to prime the administration

o set manually, using gravity. However, it is recommended to prime
the administration set using the pump. For more information, refer
to Automatic Priming Using the Pump on page 51.

> To prime the administration set manually:
1. Open all the clamps on the administration set.

2. To allow free flow, open the AFFV by pushing it in and down, towards the center
of the Q Core administration cassette (#1 in Figure 4.4).

3. Fill the entire administration set with fluid, so that the fluid displaces all air in the
administration set.

0 When priming a set with a filter; the filter must remain lower than
the patient line.
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4. To block free flow, close the AFFV by pushing it up and away from the center of
the cassette (#2 in Figure 4.4).

Figure 4.4. Opening and Closing the AFFV

Closed AFFV Opened AFFV Closed AFFV

Although the AFFV offers automatic free flow protection, a small

A amount of fluid (up to 0.12 mL) may be expelled when the
administration cassette is attached. In order to ensure full
protection, insert the administration cassette to the pump housing
before connecting the set to the patient.

o To use as a gravity set, fix the AFFV in an open position as described
in step 2 in To prime the administration set manually on
page 53.
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Chapter 5: Using the Delivery Modes

The following sections explain how to operate the pump in the different delivery
modes. After setting up the pump and the infusion, always check the battery status to

ensure it is sufficient for the desired infusion program.
Continuous Mode 56

MUILI-STEP MO .ttt 71

Continuous Mode

The following sections will be reviewed:
Infusion Parameters: Continuous Mode ...........cocviiieiiiiiiiie e 59
Starting a Continuous Infusion
Continuous Mode: Mid-infusion Actions

In this mode, the pump infuses fluid at a constant, programmed rate.

Figure 5.1. Continuous Flow Profile
Rate
(r|'||-tl|’|)
é
VTBI (mL)

Time w
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The IVVet pump can also be configured to support Secondary (Piggyback) infusions.
The Secondary option is used when two medications are administered from two
different bags; The user may either alternate between the bags or administer them

sequentially.

To use the Secondary option, the option must be enabled (requires
Technician authorization code).

Figure 5.2.
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When the Secondary option is enabled, you can set Secondary infusion parameters:

® Immediately after programming the Primary infusion (Starting a Continuous
Infusion Using the Secondary Function on page 61).
OR

®  While a Primary infusion is already running (Adding a Secondary Line on page 68).

A Piggyback Option: Safety Precautions

When working with Secondary infusions, adhere to the following instructions and
guidelines:

®  Use only Q Core administration sets designed for Piggyback infusions. (For more
information, refer to Q Core Approved Administration Sets on page 33.)

®  Hang the Secondary solution container at least 8 inches above the Primary
solution fluid level.

®  Use the drip chamber on the set to verify that the correct line is delivering and the
other line is idle.

®  After the Secondary infusion is complete, clamp the Secondary administration set.
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Infusion Parameters: Continuous Mode

The following infusion parameters are relevant for a Continuous infusion. When
programming the infusion, it is necessary to specify two of the parameters. The third
parameter is then automatically calculated by the pump.

Parameter Description/Notes

Rate The speed at which the fluid is infused. Rate values can
range from 0.1 to 999 mL/h.
Note: When selecting units that are not from the mL/h
family, the word Rate is replaced with Dose Rate.

VTBI The total amount of fluid to be infused. VTBI values can
range from 0.1 to 9999 mL.
The remaining VTBI is displayed on the screen as the
infusion progresses.

Time The period of time over which the fluid is infused. The range
for the Time value varies according to the VTBI and Rate.
The upper limit of the Time value is 99 hours and 59
minutes.

Starting a Continuous Infusion

The following procedure explains how to program the pump to start a new Continuous
infusion.

o If relevant, you may skip programming by using the Repeat Last
Infusion or PreSet programs procedures to begin the infusion. For
more information, refer to Starting New Infusions: Shortcuts on

page 78.

> To begin a new Continuous infusion:

1. From the Indicators Bar, verify that the pump is in Continuous mode.

o For more information about changing delivery modes, refer to
Selecting Delivery Mode on page 38.

2. From the Start Up screen, select New Infusion.
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3. From the Edit screen, program 2 of the following 3 parameters, by selecting the
relevant rows:
® Rate: Using the keypad, enter the value = OK.
® VTBI: Using the keypad, enter the value = OK.
® Time: Using the keypad, enter the value = OK.
The third (unprogrammed) parameter is then automatically calculated by the
pump and displayed in the relevant box.

4. Review the parameters displayed on the Confirm screen.

Verify that the parameters reflect the correct treatment according to
the prescription.

Then, press OK.

o If the pump is configured to support Secondary infusions,
Secondary infusion parameters can be programmed at this point.
For detailed instructions, go to Step 3 on page 61 .

5. Make sure that the clamps on the administration set are open; then, press Start.

The Running screen is displayed, and the infusion begins.

Throughout the infusion, the following information is displayed on the screen:

° Rate: Current infusion rate. For all dose units other than mL/h, the calculated rate
will be displayed in mL/h, both in the View system menu and in the Running
screen.

®  VTBI: Total volume left to be infused during the current infusion. As the infusion
progresses, this value decreases.

®  VI/ Total: Total volume (including KVO if applied during a delayed start period) /
the VTBI value programmed. As the infusion progresses, the VI increases, and the
Total remains constant.
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Time left: Time remaining until the end of the current infusion.

o To view all programmed parameters of the current infusion,
including the rate in mL/h, from the Running screen, press View/
Edit - View system — Infusion values.

Starting a Continuous Infusion Using the Secondary Function

The following procedure explains how to program a Continuous infusion using both
Primary and Secondary lines.

> To begin a new Continuous infusion using the Secondary option:

1.
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Verify that the pump is in Continuous mode, and then enter parameters for the
Primary infusion (Step 2 on page 59 through Step 3 on page 60 in To begin a new
Continuous infusion).

Review the parameters displayed on the Confirm screen.

Verify that the parameters reflect the correct treatment according to
&2 the prescription.

Then, press OK.
From the Start screen, select Set Secondary.
Program 2 of the following 3 parameters, by selecting the relevant boxes:

® Rate (Secondary): Using the keypad, enter the value = OK.

® VTBI (Secondary): Using the keypad, enter the value - OK.

® Time (Secondary): Using the keypad, enter the value > OK.

The third (unprogrammed) parameter is then automatically calculated by the
pump and displayed in the relevant box.

Review the parameters displayed on the Confirm screen.

Verify that the parameters reflect the correct treatment according to
the prescription.

Then, press OK.
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6. From the Start screen, select one of the following:

® Start secondary: The Attention screen appears. After verifying that the clamps
on the Secondary administration set are open, press OK. The Secondary
screen appears, and the Secondary infusion begins. When the Secondary
infusion is complete, the pump automatically continues with the Primary
infusion.

® Start primary: The Attention screen appears. After closing the clamp on the
Secondary administration set, make sure that the clamps on the primary
administration set are open; then, press OK. The Primary screen appears, and
the Primary infusion begins.

Throughout the infusion, the Indicators Bar displays information regarding the current
infusion (Primary, Secondary or the name of the drug infused). After the secondary
infusion is completed, the pump automatically switches to the primary line, and beeps
to notify the user. The following information is displayed on the Primary/Secondary
screen:

®  Rate: Current infusion rate. For all dose units other than mL/h, the calculated rate
will be displayed in mL/h, both in the View system menu and in the Running
screen.

®  VTBI: Total volume left (in the current infusion) to be infused. As the infusion
progresses, this value decreases.

®  VI/ Total: Total volume (including KVO if applied during a delayed start period) /
the VTBI value programmed. As the infusion progresses, the VI increases, and the
Total remains constant.

®  Time left: Time remaining until the end of the current infusion.

0 You can switch between the two infusions at any time. For more
information, refer to Switching between Primary and Secondary
Infusions on page 69.

To view all programmed parameters of the current infusion, including the
0 rate in mL/h, from the Running screen, press View/Edit > View

system — Infusion values.

For all dose units other than mL/h, the calculated rate will be displayed in

mL/h, both in the View system menu and in the Running screen.
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Continuous Mode: Mid-infusion Actions
The following actions can be performed during Continuous infusions:

Updating Infusion Parameters ...........ccocoviiiiiiiincincciccscecee e 63
AdmiInistering @ BoIUS ..couieiiiiiiiie e 64
Adding @ SeconNdary LN ......coieeiiiiiiiieenie ettt 68
Switching between Primary and Secondary Infusions .........cccoceveiieniiiciiennns 69

PaUSING INTUSIONS ..ttt ettt et
Aborting Infusions

Locking the Screen

Updating Infusion Parameters

Infusion parameters can be modified by using the View/Edit function key. In addition,
you can modify the rate, VTBI, and time left directly from the Running, Primary or
Secondary screen.

> To update current parameters directly from the screen:
1. On the Main Display, select the relevant parameter (Rate, VTBI or Time left).
2. Using the keypad, enter the new value of the parameter - OK.

3. To confirm and save changes, press OK.
To return to the original infusion screen without saving changes, press Back.

> To update parameters using the View/Edit function key:

1. From the toolbar, press View/Edit.

2. Select the box of the parameter to be updated.

3. Using the keypad, enter the new value of the parameter - OK.
4. To update other parameters, repeat Steps 2-3.

In addition to parameter changes, the following actions are also available:

® Clear Accum. VI: Resets the total volume infused via all infusions associated
with the current patient to O mL. For more information, refer to Clearing
Accumulated VI on page 112.

® View system: Displays various system and pump parameters. (Refer to View
Menu on page 97.)
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® Edit Primary/Secondary Line: Allows you to update infusion parameters of
the infusion that is not currently running. The pump will prompt you to pause
the infusion while updating these parameters.
5. To confirm and save changes, press OK.

To return to the original infusion screen without saving changes, press Back. Then,
from the Attention screen, press OK.

Administering a Bolus

The Bolus feature enables administration of a fast dose, when rapid volume infusion in
the Continuous mode is necessary.

Bolus delivery allows infusion at high rates. Only certified medical
A personnel should use this feature.

> To deliver a bolus:

1. From the toolbar of the Running, Primary or Secondary screen, press Bolus.

0 For the Bolus button to appear on a Continuous running infusion,
the pump needs to be configured to the Allow Bolus setting. The
Allow Bolus setting can be modified by Technicians only. For more

information, refer to the Service Manual.

2. Ifthe Patient Weight screen appears, using the keypad, enter the Patient Weight
- OK.

3. According to configuration, one of the following screens will appear:
* Edit:
® Amnt (Bolus): Using the keypad, enter the Bolus Amount = OK (the
acceptable range varies, according to the current VTBI).

o Trying to enter one of the unavailable (grayed out) boxes, triggers a
message requesting to enter the Bolus amount first.

Enter one of the following parameters, by selecting the relevant box:
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® Rate (Bolus): Using the keypad, enter the Bolus Rate = OK.

® Time (Bolus): Using the keypad, enter the Bolus Time - OK.

The third (unprogrammed) parameter is then automatically calculated by the
pump and displayed in the relevant box.

Continue to Step 4.

® Bolus Amount: Using the keypad, enter the Bolus Amount = OK (the
acceptable range varies according to the current VTBI). Then, continue to
Step 5.

o When trying to exit programming before its completion, a message
is displayed stating that the data entered has not been saved.

Q When the bolus is programmed by amount only, the default bolus
rate is 125 mL/h. This default can be modified using a Technician

authorization code.
When the infusion rate is higher than 125 mL/h, the bolus rate will
be 1 mL/h faster than the infusion rate.
During a bolus, some of the parameters can be updated from the
Bolus delivery screen. For more information, refer to Updating
Bolus Infusion Parameters on page 66.

Review the parameters displayed on the Confirm screen.

Verify that the parameters reflect the correct treatment according to
the prescription.

Then, press OK.
To start the bolus, from the Attention screen, press OK.

The Bolus delivery screen is displayed, and the bolus begins.
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Throughout the bolus, the following information is displayed on the screen:

®  Bolus Rate: Current infusion rate.
®  Bolus VTBI: Total bolus amount left to be infused. As the bolus progresses, this
value decreases.

®  Bolus VI / Total: Total bolus amount that has been infused during the current
infusion / the total bolus amount programmed. As the infusion progresses, the
Bolus VI increases, and the Total remains constant.

®  Time left: Time remaining until the end of the bolus.

When the bolus is complete, a message appears on the Main Display.

Mid-bolus Actions
The following actions can be performed during bolus delivery:
Updating Bolus Infusion Parameters ........c.ccocevirireneniineneniereieeeeereeeeenenes 66
PaUSING @ BOIUS oottt
Aborting a Bolus

Updating Bolus Infusion Parameters
Bolus infusion parameters are updated directly from the Bolus delivery screen.
> To update parameters from the Bolus delivery screen:

1. On the Main Display, select the relevant frame (Bolus Rate, Bolus VTBI or Time
Left).

0 The Time Left parameter is not configurable, when the bolus was
programmed by amount only.

2. Using the keypad, enter the new Rate, VTBI or Time left = OK.
3. From the Attention screen, press OK.
Updated parameters are displayed.
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Pausing a Bolus
When necessary, you can temporarily stop the bolus.
> To pause a bolus:

®  From the toolbar of the bolus delivery screen, press Pause Bolus. Then, from the
Attention screen, press OK.
Alternatively, press the Stop hard key.
All volume delivery stops.

> To resume a paused bolus:
1. From the toolbar of the bolus delivery screen, press Continue Bolus.

2. From the Attention screen, press OK.

Aborting a Bolus

The following procedures involve pausing and then permanently quitting the bolus,
with the option to quit the entire infusion.

> To abort a bolus and quit all infusions:

1. Press the Stop hard key. Alternatively, press the Pause Bolus, then press OK.
The bolus is paused.

2. From the toolbar, press Quit Bolus.

w

From the toolbar of the Paused screen, press Quit.

4. From the Attention screen, press Quit infusion.

0 Resuming infusion after quitting will not be possible.

> To abort a bolus and continue the infusion (Secondary option not in use):

1. Press the Stop hard key. Alternatively, press the Pause Bolus, then press OK.
The bolus is paused.

2.  From the toolbar, press Quit Bolus.

3. From the toolbar of the Paused screen, press Request Continue.
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4.

From the Attention screen, press OK.

> To abort a bolus and continue the infusion (Secondary option in use):

1.

ok wN

Press the Stop hard key. Alternatively, press the Pause Bolus, then press OK. The

bolus is paused.

From the toolbar, press Quit Bolus.

From the toolbar of the Paused screen, press Switch or Continue.
From the Start screen, press Primary or Secondary.

From the Attention screen, press OK.

Adding a Secondary Line

The following procedure explains how to add a Secondary line while a Primary infusion
is already running.

0 If you have already programmed the Secondary infusion, and want
to start it, refer to Switching between Primary and Secondary
Infusions on page 69.

Before programming a Secondary infusion, verify that the

A administration set you are using is appropriate for Secondary
(Piggyback) infusions. For more information, refer to Q Core
Approved Administration Sets on page 33.

> To add a Secondary line while a Primary line is running:

1.
2.
3.

From the toolbar, press View/Edit.
Select Add Sec. Line.

Program 2 of the following 3 parameters, by selecting the relevant boxes:

® Rate (Secondary): Using the keypad, enter the value - OK.

® VTBI (Secondary): Using the keypad, enter the value - OK.

® Time (Secondary): Using the keypad, enter the value - OK.

The third (unprogrammed) parameter is then automatically calculated by the
pump and displayed in the relevant box.
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Review the parameters displayed on the Confirm screen.

Verify that the parameters reflect the correct treatment according to
the prescription.

Then, press OK.
From the Start screen, select one of the following:

® Start secondary: The Attention screen appears. After verifying that the clamps
on the Secondary administration set are open, press OK. The Secondary
screen appears, and the Secondary infusion begins. When the Secondary
infusion is complete, the pump automatically continues with the Primary
infusion.

® Continue primary: The Primary screen appears, and the Primary infusion
begins.
For more information about switching from one infusion to the other, refer to
Switching between Primary and Secondary Infusions on page 69.

Switching between Primary and Secondary Infusions

Switching between infusions involves pausing the infusion that is currently running, and
then starting or continuing the other infusion.

> To switch from the Primary to the Secondary infusion:

1.

69

Pause the Primary infusion:

From the toolbar of the Primary screen, press Request Pause. Then, from the
Attention screen, press OK.
Alternatively, press the Stop hard key.

From the toolbar of the Primary screen, select Switch or Continue.
From the Start screen, select Start secondary.

The Attention screen appears. After verifying that the clamps on the Secondary
administration set are open, press OK. The Secondary screen appears, and the
Secondary infusion begins.
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> To switch from the Secondary to the Primary infusion:

1. Pause the Secondary infusion:
From the toolbar of the Secondary screen, press Request Pause. Then, from the
Attention screen, press OK.
Alternatively, press the Stop hard key.

2. From the toolbar of the Secondary screen, select Switch or Continue.
3. From the Start screen, select Continue primary (or Start primary).

The Attention screen appears. After verifying that the clamps on the Secondary
administration set are closed, and that the clamps on the primary set are open,
press OK. The Primary screen appears, and the Primary infusion begins.
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Multi-step Mode

The following sections will be reviewed:

Infusion Parameters: Multi-step Mode .......ccceviiiiiiiiiiiiiiiicccccee, 72
Starting a Multi-step INfUSION ..o 72
Multi-step Mode: Mid-infusion Actions .........cccceciviiiiiiiicniicicccceecee, 75

This mode allows the pump to deliver a series of up to 25 consecutive infusion Steps
from the same infusion container. Each Step is delivered as a Continuous infusion, at its
own pre-programmed parameters. Although the infusion rates of each Step can differ,
the rate within a single Step does not vary (constant, continuous infusion).

Figure 5.3. Multi-step Flow Profile
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Infusion Parameters: Multi-step Mode

When programming a Multi-step infusion, the number of Steps must be specified.
Infusion parameters relevant to each Step are listed in the following table. During
programming, it is necessary to specify two of the three parameters. The remaining

parameter is then automatically calculated by the pump.

Parameter Description/Notes

Rate The speed at which the fluid is infused. Rate values can range from
0.1 to 999 mL/h.
Note: When selecting units that are not from the mL/h family, the
word Rate is replaced with Dose Rate.

VTBI The total amount of fluid to be infused. The remaining VTBI is
displayed on the screen as the infusion progresses. VTBI values can
range from 0.1 to 9999 mL.

Time The period of time over which the fluid is infused. The acceptable
range for time values vary according to the VTBI. The maximum
Step time is 24 hours.

Starting a Multi-step Infusion

The following procedure explains how to program the pump to start a new Multi-step
infusion.

o If relevant, you may skip programming by using the Repeat Last
Infusion or PreSet programs procedures to begin the infusion. For
more information, refer to Starting New Infusions: Shortcuts on
page 78.

> To begin a new Multi-step infusion:

1. From the Indicators Bar, verify that the pump is in Multi-step mode.

0 For more information about changing delivery modes, refer to
Selecting Delivery Mode on page 38.

2. From the Start Up screen, select New Infusion.
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For the first Step, program 2 of the following 3 parameters, by selecting the
relevant boxes (the digit refers to the number of the Step):

® Rate 1: Using the keypad, enter the value = OK.

® VTBI 1: Using the keypad, enter the value = OK.

® Time 1: Using the keypad, enter the value = OK.

The unprogrammed parameter is then automatically calculated by the pump, and
displayed in the relevant box.

After reviewing the infusion parameters for the current Step (as displayed on the
Indicators Bar), press OK to proceed and program the next Step.

To program parameters for the remaining Steps of the infusion, repeat Step 3

through Step 4 of this procedure.

After the final Step is programmed, the Confirm screen appears, displaying the

following parameters:

® Total VTBI: Amount of fluid to be delivered during the entire infusion.

® Total time: Time period of the entire infusion.

® Number of steps: Number of Steps making up the total infusion.

® Review Steps details: Selecting this option displays the parameters of all
programmed Steps, screen by screen (with each step displayed in its own
screen).

Review the parameters displayed on the Confirm screen.

Verify that the parameters reflect the correct treatment according to
the prescription.

Then, press OK.
Make sure that the clamps on the administration set are open; then, press Start.

The Running screen is displayed, and the infusion begins.
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Throughout the infusion, the current Step number is displayed on the Indicators Bar
(e.g., Running 1/6) and next to parameter on main display (Rate 1,VTBI 1 and Time 1).
The transition between steps is accompanied by a beep. In addition, the following
information appears on the screen:

Rate: Current infusion rate. For all dose units other than mL/h, the calculated rate
will be displayed in mL/h, both in the View System menu and in the Running
screen.

VTBI: Total volume left to be infused during the current Step.

VI / Total: Total volume (including KVO if applied during a delayed start period) /
the total VTBI (for the entire infusion). As the infusion progresses, the VI increases,
and the Total remains constant.

Time left: Time remaining until the end of the entire infusion.

Step Time: Time remaining until the end of the current Step.

To view all programmed parameters of the current infusion,

0 including the rate in mL/h, from the Running screen, press View/
Edit - View system — Infusion values.
For more information, refer to Viewing System Parameters on
page 98.
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Multi-step Mode: Mid-infusion Actions
The following actions can be performed during Multi-step infusions:

Updating Step Parameters .........cccoiviiiiiiiiiiiiiicicce e 75
PaUSING INTUSIONS ..ttt ettt 81
ADOTtING INTUSIONS .ttt 82
LoCkiNg the SCre@n oot 83

Updating Step Parameters

Infusion parameters for the current Step can be modified directly from the Running
screen. In addition, infusion parameters for the current Step and the following Step can

be updated by using the View/Edit function key.

Parameters for only the current Step and the Step immediately
0 following it can be modified.

0 If the step being updated ends before the change is made or
confirmed, the change will not be made and an Attention screen
will appear.

> To update current Step parameters from the Running screen:

1. Select the frame of the parameter that you want to update (Rate, VTBI or Step
Time).

2. Using the keypad, enter the new rate, VTBI (during the Step), or time remaining
until the end of the Step - OK.

3. To confirm and save changes, press OK.
To return to the original infusion screen without saving changes, press Back.

75 Vet Infusion Pump User Manual



> To update parameters of the current or next Step using the View/Edit func-

tion key:
1. From the toolbar, press View/Edit.
2. Select the box of the relevant parameter.
3. Using the keypad, enter the new value of the parameter = OK.
4. To update other parameters, repeat Steps 2-3.
In addition to parameter changes, the following actions are also available:
® Clear Accum. VI: Resets the total volume infused via all infusions associated
with the current patient to O mL. For more information, refer to Clearing
Accumulated VI on page 112.
® Next step: Allows you to update infusion parameters of the Step following the
current Step. (This box appears only if there is a Step following the current
Step.)
® View system: Displays various system and pump parameters.
5. To confirm and save changes, press OK.

To return to the Running screen without saving changes, press Back.
Then, from the Attention screen, press OK.
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Chapter 6: Basic Infusion Operations

The following sections explain procedures and actions that are commonly performed in
all delivery modes to start and manage infusions:

Starting New INfusions: SHOMCULS ...e.eiieiirierieiee e 78
Resuming Infusions After Pump Shutdown .........cccooeiiiiiiniiniccee, 80
Mid-INTUSION ACHIONS .eirenieiieiieiteiteieeieeic ettt sttt eveeee e 81

Starting New Infusions: Shortcuts

The following shortcut operations allow you to begin an infusion without the need to
enter required parameters:
Repeating Last INfUSION ... 78
UsiNg @ PreSet Program ....c..eeioieeeriiieiiee ettt 79

Repeating Last Infusion

Repeat Last Infusion is a quick method to continue the infusion with a new IV bag, after
the first one has been emptied or discontinued (the same infusion parameters used for
the same patient). The pump automatically saves all the parameters programmed,
excluding secondary line, for the last infusion performed in that delivery mode. If a
parameter is updated while an infusion is running, the updated parameter is saved. The
Last Infusion settings are saved even if the last infusion was not completed or the pump
has been turned Off.

0 When using the Repeat Last Infusion option, the Accumulated VI
parameter and the remaining Lockout Time are not cleared;
instead they continue counting from the previous infusion. For more
information about Accumulated VI, refer to Using the New
Patient Feature on page 110.
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0 Information about Secondary (Piggyback) infusions is not saved.
This option is not relevant to Secondary infusions.

> To repeat the last infusion:

1.
2.

From the Start Up screen, select Repeat Last Infusion.

Review the parameters displayed on the Confirm screen.

Verify that the parameters reflect the correct treatment according to
the prescription.

Then, press OK.

To begin the infusion, make sure that the clamps on the administration set are
open, and press Start.

The Running screen appears, and the infusion begins.

Using a PreSet Program

The PreSet Programs function allows you to select an infusion with predefined
parameters. Each delivery mode can support up to 10 PreSet programs. PreSet
programs are available only in the delivery mode in which they were saved.

> To start an infusion using the PreSet Programs function:

1.

2.

79

From the Start Up screen, select PreSet Programs.

0 If no PreSet program was saved in the current delivery mode, a
blank screen appears.
For more information about adding or modifying a program, refer
to Creating and Editing PreSet Programs on page 104.

Select the row of the desired program.

0 To display additional programs, press Next.
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Review the parameters that are displayed.

Verify that the parameters reflect the correct treatment according to
the prescription.

Then, press OK.

To begin the infusion, make sure that the clamps on the administration set are
open, and press Start.

The Running screen appears, and the infusion begins.

Resuming Infusions After Pump Shutdown

When the pump is turned Off during an active infusion (running or paused), the option
to resume the previous infusion will be displayed after the pump is turned On. This
option is applicable for all delivery modes, excluding TPN:

To resume the infusion: on the Attention screen, press OK. The running screen

appears.

0 The option to resume will not be available if the pump was shut
down due to a critical alarm, or if the infusion was quit.

To abort the previous infusion: on the Attention screen, press Exit. The Start Up
screen appears.
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Mid-infusion Actions

The following sections describe procedures that are commonly performed during an
infusion:
Pausing INTUSIONS ..eiiiiieiiecit ettt
Aborting Infusions ....
Locking the Screen

Pausing Infusions

The Pause function allows you to temporarily stop an infusion. Infusions can be paused
using either the Request Pause function key, or, in an emergency, the Stop hard key.
A message stating that the infusion has been paused appears 30 seconds after pausing

the infusion (audible and visual).

e Pressing the Stop hard key stops the infusion immediately,
bypassing the need for confirmation of the Pause action. In an
emergency, it is recommended to pause the infusion using the
Stop hard key. In routine situations, using the Request Pause
function key is recommended.

e Turning the pump Off after pausing the infusion allows the user to
resume this infusion after turning the pump back on.

> To pause an infusion using the Stop hard key:

® At the bottom of the pump, press Stop. The infusion is paused.

0 When the Lock Screen features are activated, it is necessary to
confirm pausing from the Attention screen, by pressing OK.

> To pause an infusion using the Request Pause function key:
1. From the toolbar, press Request Pause.

2. From the toolbar of the Attention screen, press OK.
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3. The infusion is paused.

o If you do not press OK within 30 seconds, the infusion is not
paused, and the Running screen reappears.

> To resume a paused infusion:
1. From the toolbar, press Request Continue.

2. From the toolbar of the Attention screen, press OK.

Aborting Infusions
Aborting an infusion is performed using one of the following methods:

®  Pausing and then quitting the infusion: Returns the pump to the Start Up screen.

Resuming the infusion after quitting is impossible.

®  Turning off the pump: Turns the pump Off mid-infusion, using the On/Off hard

key.

When the pump is turned Off mid-infusion, the infusion parameters are saved. When

the pump is turned back On, the user is prompted to indicate whether or not to
continue the stopped infusion.

0 In an emergency situation, it is recommended to press and hold the
ON/OFF hard key for 5 consecutive seconds. This turns the pump
Off, bypassing the need to confirm the action.

> To pause and then quit an infusion:
1. At the bottom of the pump, press the Stop hard key.
2. From the toolbar, press Quit.

3. From the toolbar of the Attention screen, press Quit Infusion.

0 Resuming infusion after quitting will not be possible.
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> To turn Off the pump:
1. Atthe bottom of the pump, press the ON/OFF hard key.

o If a rate of <1 mL/h was used, the pump will prompt the user to take
the administration cassette out of the pump before turning the
pump Off.

2. From the toolbar, press Off.

Pressing and holding the ON/OFF hard key for 5 consecutive seconds turns the
pump Off (bypassing the need for confirmation).

o In case of emergency, when the Lock Screen is activated, the user
must press and hold ON/OFF for 5 seconds to turn the pump Off,
or unlock the pump before turning it Off.

Locking the Screen

Locking the display screen prevents inadvertent and unintentional changes to settings,
by disabling the functionality of the touch screen. For safety, it is recommended to lock
the screen while an infusion is running.

> To lock the screen:
1. From the toolbar of the Running screen, press Lock.

2. On the Lock options screen, select Lock Screen.

The > icons on the Main Display and the toolbar function keys disappear. Only the
Press to Unlock Screen function key appears on the toolbar.

> To unlock the screen:
1. From the toolbar, press Press to Unlock Screen.

2. From the toolbar of the Attention screen, press OK.
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Ending Infusion

When the infusion is complete (entire programmed VTBI delivered), the pump

automatically activates the KVO (the default or the infusion rate, the lower of the two)

and displays the infusion summary:

®  VI-volume infused (VI for the current completed infusion. If the Accumulated VI

has been cleared during this infusion, VI presents the volume infused from that
time on).

®  Rate —the rate at which the infusion was delivered

® Total time — the total time of the infusion

0 The default KVO can be set by an authorized technician.

0 When the remaining VTBI is 0.1 mL or less, the time left displayed
on the screen may deviate up to a few minutes from the actual time
remaining.

> To proceed with the KVO and view the KVO screen:
®  From the toolbar of the Message screen, press OK.

> To discontinue the KVO:

1. From the toolbar of the Message screen, press OK.

2. From the toolbar of the KVO screen, press Quit.
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Chapter 7: Options Menu: Configuring,

Viewing and Testing

The following sections describe configuring settings, testing elements, and viewing
system data using the Options menu:

Main Options: OVErVIEW ........cccccciiiiiiiiiiiiiiiiiiii s 86
Setting Delivery MOde ......coiiiiiiiieie ettt 87
Managing Configuration SETHNGS «....cecererirerinirenenene et 88

Main Options: Overview

The Options screen provides access to configurable pump settings, testing modes, and
system data. The screen is displayed by pressing the Options function key, on the
toolbar of the Start Up screen.

The Options screen allows access to all configurations and settings of the IVVet pump
(as opposed to settings relevant to a specific infusion). The screen also provides access
to testing components and viewing pump (as opposed to infusion) parameters (e.g.,

System parameters Event logs).

o The Options function key is not available during an infusion. Some
of the configuration and information accessed from the Options
menu is also accessible during infusion via the View/Edit menu.
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Setting Delivery Mode

The IVVet pump is a multi-platform device that has the ability to operate in several
different modes. Each delivery mode features its own unique options. The current
mode is displayed at the right side of the Indicators Bar.

Setting the delivery mode is done using the Options menu. An authorization code of
High or Technician is required to modify the delivery mode.

o When you change the delivery mode, the pump reverts to the
default values for the newly selected mode.

> To change the delivery mode:

1 From the toolbar, press Options.

2. From the Options screen, select Delivery mode.

3. Using the keypad, enter the required password, and then press OK.
4

Select the relevant delivery mode.

The Start Up screen of the selected mode appears.
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Managing Configuration Settings

The following sections describe how to view and update pump configuration settings:
Managing Alarm SETHINGS ..eceeviierieeieiieeieesie ettt ste st sete et e sebeebeesereens
Configuring Audio Settings ......
Configuring General Settings

Defining Regional Parameters ........ccceeiieecieniiiieenie ettt 94
Testing System FUNCHION cooouiiiiiiie ittt 96
VIEW IMENU .ttt 97
0 When a drug library is loaded to the pump, local configurations

made on the pump remain valid until the user selects a CCA or turns

the pump Off. For more information refer to Chapter 9: Drug
Library on page 153.

Managing Alarm Settings

The Alarms menu allows you to view and modify alarm-related options. Only users with
authorization levels of High or Technician have access to this menu.

> To access the Alarms menu:

®  From the toolbar of the Start Up screen, select Options. Then, select Pump
configuration - Alarms.

To Modify Parameter

(from the Alarms

Descriptions/Notes screen)
Occlusion units The format of occlusion units (BAR, PSl or  Select Occlusion units.
mmHg). Then, select BAR, PSI or

mmHg.
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Descriptions/Notes

To Modify Parameter

(from the Alarms
screen)

Occlusion
pressure

Pump unattended

Infusion near end

The minimum downstream pressure that
triggers an Occlusion alarm. Acceptable
ranges are 5.8 to 17.4 PSI, 0.4 to 1.2 BAR
or 300 to 900 mmHg. An alarm sounds
when the downstream pressure reaches
the set value * the sensor sensitivity level.

The number of consecutive minutes of no
interaction with the pump after which a
Pump Unattended alarm is triggered.
Options are 2, 5 or 10 minutes.

Note: A Pump Unattended alarm is not
triggered when the pump is in Delayed
start or Standby.

The number of minutes before completion
of an infusion at which an Infusion Near
End alarm is generated.

Note: The Infusion Near End alarm is
triggered only once in a treatment.

Select Occlusion
pressure. Then, using the
keypad, enter the desired
value = OK.

Select Pump
unattended. Then,
select 2 min, 5 min or
10 min.

Select Infusion near
end. Then, select 1 min,
3 min, 5 min, 10 min or
Off.
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To Modify Parameter

(from the Alarms

Descriptions/Notes screen)

Alarm volume Sets the speaker volume for the auditory Select Alarm volume.
alarm signal. Options are Maximum or Then, select Maximum or
Minimum. Minimum.

When the option is set to Minimum,
messages are provided with a visual signal
only. Alarm levels 1, 2 and 3, and the
'Infusion Complete' message are provided
with a visual signal and the lowest auditory
signal permitted, according to

IEC 60601-1-8.

Maximum alarm volume is 70 dB.
Minimum alarm volume is 56 dB.

Note: Auditory alarm signal sound levels,
which are less than ambient levels, can
impede operator recognition of alarm
conditions.

For more information about messages and
alarms, refer to Chapter 9: Alarms and
Troubleshooting on page 114.

o An Occlusion Auto-restart option exists and is available for
configuration by authorized technicians only. This option allows the

pump to restart the infusion automatically provided the occlusion
was cleared.
If the occlusion is not cleared within 40 seconds, or the user chooses
to exit the process, or the user chose to exit the process, the
downstream occlusion alarm is activated (appears within a few
seconds). (appears within a few seconds) An Occlusion Auto-restart
can occur up to 5 times in one hour.
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Configuring Audio Settings

The Audio settings menu allows you to view and modify audio-related pump settings.
Only users with authorization levels of High or Technician have access to this menu.

> To access the Audio settings menu:

®  From the toolbar of the Start Up screen, select Options. Then, select Pump
configuration - Audio settings.

To Modify Parameter

(from the General

Descriptions/Notes settings screen)

Keys volume Sets the speaker volume for the auditory  Select Keys volume.
signal generated when users select Then, select Low, High or
functions and press keys on the pump. Off.

Alarm volume Sets the speaker volume for the auditory  Select Alarm volume.
alarm signal. Options are Maximum or Then, select Maximum or
Minimum. Minimum.

When the option is set to Minimum,
messages are provided with a visual
signal only. Alarm levels 1, 2 and 3, and
the 'Infusion Complete' message are
provided with a visual signal and the
lowest auditory signal permitted,
according to IEC 60601-1-8.

Maximum alarm volume is 70 dB.
Minimum alarm volume is 56 dB.

Note: Auditory alarm signal sound
levels, which are less than ambient levels,
can impede operator recognition of
alarm conditions.

For more information about messages
and alarms, refer to Chapter 9: Alarms
and Troubleshooting on page 114.
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Configuring General Settings

The General settings menu allows you to view basic pump settings, and modify them
according to clinical requirements. Only users with authorization levels of High or
Technician have access to this menu.

> To access the General settings menu:

®  From the toolbar of the Start Up screen, select Options. Then, select Pump
configuration > General settings.

Descriptions/Notes

To Modify Parameter

(from the General
settings screen)

Authorization
level

Allow delayed
start

Allow
PreProgram

Set prime volume

Sets the authorization lock level of the
pump. For more information, refer to
Managing Authorization Levels on
page 102.

Enables users to start an infusion at a later
time. The user may either define a specific
delay period, or set the pump to Standby.
For more information, refer to Using the
Set Delay Feature on page 107.

Enables/disables starting infusions using
predefined infusion parameters. When the
option is enabled, the PreSet Programs
frame appears on the Start screen.

For more information, refer to Creating
and Editing PreSet Programs on

page 104.

The amount of fluid used to prime the
administration set when automatic priming
is performed. The acceptable range is 2 to
25 mL.
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Select Authorization
level. Then, enter a
password and select High
or Tech.

Select the Allow
delayed start row, to
toggle the option between

On and Off.

Select the Allow
PreProgram row, to
toggle the option between

On and Off.

Select Set prime
volume. Then, using the
keypad, enter the desired
value > OK.
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To Modify Parameter

(from the General
settings screen)

Backlight

Prime Reminder

Advanced Bolus

93

Descriptions/Notes

Allows the user to set the degree of screen
brightness for a running infusion. Backlight
can also be modified during a running
infusion. The Off and Partial options of this
feature save power and promote longer
battery life.

Enables a reminder for the user to prime
the administration set before starting an
infusion.

For more information, refer to Automatic
Priming Using the Pump on page 51.

Allows users to program a bolus by
entering rate, amount and time. When this
option is disabled, the bolus is
programmed by amount only, and the rate
is the default bolus rate. The option is
available only when Allow Bolus is enabled
(by a Technician authorization code).
Applicable only for the Continuous
delivery mode.

For more information, refer to
Administering a Bolus on page 64.

Select Backlight. Then,
select On, Off or Partial.

Select the Prime
Reminder row, to toggle

the option between On
and Off.

Select the Advanced
Bolus row, to toggle the
option between On and

Off.
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To Modify Parameter

(from the General

Descriptions/Notes settings screen)

Screen Saver Enables/disables a far-view display of the Select the Screen Saver
main infusion parameters during a running  row, to toggle the option
infusion. These include drug information, between On and Off.

delivery mode (color indication), infusion

rate, and the phase (dose, continuous rate

etc.). The screen saver appears 30 seconds

after the infusion program has started, and

the pump has not been touched.

The screen saver will not appear in the

following cases: Delayed start, end of

infusion KVO, or during a Bolus delivery.

The screen saver will disappear in the

following cases:

® Alarm — screen will revert to the alarm
screen

® Touching the screen — screen will revert
to the Running screen

® Infusion is paused — screen will revert to
the Paused screen.

Defining Regional Parameters

The Regional menu controls date, time, language and US format settings. Only users
with authorization levels of High or Technician have access to this menu.

> To access the Regional menu:

®  From the toolbar of the Start Up screen, select Options. Then, select Pump
configuration - Regional.
The following procedures explain how to configure settings from the Regional menu.
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> To set the date:
1.  Select the Date frame.

2. Using the keyboard, enter values (2 digits each) for the day, month, and year.
(When US format is set, the order is month, day, and year.)

3. To confirm the new settings, press OK.

> To set the time:

1. Select the Time frame.

2. Using the keyboard, enter values (2 digits each) for the hour and the minute.

3. If necessary, switch the time units from AM to PM or vice versa, by pressing the
AM/PM function key. (This step is relevant only when U.S. format is set.)

4. To confirm the new settings, press OK.
> To set the language:
1. Select the Language frame.

2. Select the desired language.

o In some pumps, only the default language is listed.

3. To confirm the new settings, press OK.

> To set the US format:

1. Select the US format frame.

2. Toggle the settings between On and Off

3. To confirm the new settings, press OK.

o The date will appear in month/day/year format and time will appear
12 hour format (am/pm) when this setting is toggled On.
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Testing System Function

The Test system menu allows you to test basic system functionalities. Only users with
authorization levels of High or Technician have access to this menu.

> To access the Test system menu:

®  From the toolbar of the Start Up screen, select Options. Then, select Pump
configuration - Test system.

Option Descriptions/Notes

Speaker high ® On: High volume auditory signal sounds.
® Off: No auditory signal.

Speaker low ® On: Low volume auditory signal sounds.

® Off: No auditory signal.

Alarm LED ® On: The red (Alarm) LED is lit.
® Off: The red (Alarm) LED is not lit.

Charge LED ® On: The yellow (Charge) LED is lit.
® Off: The yellow (Charge) LED is not lit.

Running LED ® On: The green (Run) LED is lit.
® Off: The green (Run) LED is not lit.

Door sensor ® Closed: The safety door is closed.

® Opened: The safety door is open.
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View Menu

The View menu provides access to current pump settings and lists of events that are
audited by the system. The main categories are:

Category Description/Notes

View system Provides a view of the current system settings, and allows updating
selected settings. For more information, refer to Viewing System
Parameters on page 98.

Event log Provides a view of the events recorded by the system; such as
authorization level change, programming infusion parameters,
activated alarms etc. For more information, refer to Viewing the
Event Log on page 100.

> To access the View menu from the Start Up screen:

1. From the toolbar of the Start Up screen, select Options.

2. On the Options screen, select View.

> To access the View system screen from the Running screen:
1. From the toolbar of the Running screen, select View/Edit.

2. From the toolbar of the View/Edit screen, select View system.
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Viewing System Parameters

The View system screen allows you to view current system settings and infusion
parameters, and update selected settings. You can navigate through the pages of
settings, by pressing the Next and the Back function keys.

The following settings appear in all delivery modes:

Setting Description/Notes

Infusion Values Displays all the programmed parameters of the current infusion,
including rate in mL/h. Applicable only on an active infusion, or
during Standby.

Pressing > displays the parameters.

Alarm volume The volume of the auditory alarm signal (Maximum or
Minimum). The setting can be modified by pressing >, and then
selecting a setting.

Occlusion The level of downstream pressure that triggers an occlusion
alarm. For more information, refer to Managing Alarm
Settings on page 88.
The setting can be modified by pressing >, entering a value using
the keypad, and then pressing OK.

Authorization Current authorization lock level. For more information, refer to
Managing Authorization Levels on page 102.
The setting can be modified by pressing >, selecting a setting,
and then pressing OK. Password entry is required to change the
authorization.

Backlight Current backlight settings. For more information refer to
Configuring General Settings on page 92.
The setting can be modified by pressing >; then selecting On,
Partial or Off.

Accumulated VI The cumulative volume infused (mL). The Accumulated VI can be
cleared by pressing >. For more information, refer to Monitoring
the Accumulated Volume Infused (Shift's Total) on
page 111.
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Setting Description/Notes

Accum. Prim. VI The cumulative volume infused (mL) via the primary infusions.
Appears in the View System menu only in the Continuous
Delivery mode. For more information, refer to Monitoring the
Accumulated Volume Infused (Shift's Total) on page 111.

Accum. Sec. VI The cumulative volume infused (mL) via the secondary infusions.
Appears in the View System menu only in the Continuous
Delivery mode. For more information, refer to Monitoring the
Accumulated Volume Infused (Shift's Total) on page 111.

VI cleared date The date and time in which the Accumulated VI was last cleared.
For more information, refer to Monitoring the Accumulated
Volume Infused (Shift's Total) on page 111.

VI cleared time

Delivery mode Current delivery mode.

Single Air detector These settings are associated with the amount of air that triggers
an Air in Line alarm. These settings can be modified by
Technicians only. For more information, refer to the Service
Manual.

Note: While a non-epidural infusion is running at a rate of 4 mL/h
or lower, the Single air detector switches automatically On.

Accumulated Air
detector

Accumulated Threshold

Date Current date and time. For more information, refer to Defining

Time Regional Parameters on page 94.

Software version The software version loaded on the pump.

Serial number Serial number of the pump.

Next Certification Date that the pump is due for the next Certification. For more
information refer to the Service Manual.

Set Prime Volume The amount of fluid used to prime the administration set, when
automatic priming is performed. The acceptable range is 2 to
25 mL.

Battery status The approximate percentage of current battery charge. Possible

values are 100%, 75%, 50%, 25%, and Low Batt.
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Setting Description/Notes

KVO The default KVO rate set for the current delivery mode. The
parameter is not relevant to Intermittent or Epidural Intermittent
mode (in which the KVO is equal to the KVO/continuous rate
programmed for the infusion).

Bolus rate The default bolus rate set for the current delivery mode. The
parameter is not relevant to the Multi-step modes. In continuous
mode, when the Advanced Bolus option is set to On, the bolus
Amount, Rate and Time can be programmed by the user, and the
bolus rate will not be displayed on the View System menu.
Default bolus rate can be modified by Technicians only. For more
information, refer to the Service Manual.

Secondary bolus rate The default secondary bolus rate. This parameter is relevant only
for the Continuous Delivery mode. When the Advanced Bolus
option is set to On, the bolus Amount, Rate and Time can be
programmed by the user, and the secondary bolus rate will not be
displayed on the View System menu.

Default bolus rate can be modified by Technicians only. For more
information, refer to the Service Manual.

Viewing the Event Log

The Event log screen allows you to view a record of all events audited by the system.
You can view a list of all events or only the events that occurred on a specific day.

> To view events that occurred on a specific day:
From the Options menu, select View.
On the View screen, select Event log.

On the Event log screen, select By date.

e =

Using the keypad, enter values for the day (2 digits), the month (2 digits), and the
year (2 digits). (When U.S. format is set, the order is month, day, and year.)

o To navigate directly to a component of the date (e.g., day), press
the component.
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5. On the toolbar, press OK.

A list of events is displayed.

0 If no events occurred on the selected day, a blank screen is
displayed.

> To view all events:

1. From the Options menu, select View.

2. Onthe View screen, select Event log.

3. Onthe Event log screen, select All events.

A list of events is displayed.

The Event log is sorted according to time, with the most recent event listed first. Each
event is assigned a specific code. (For example, the code for the Pump Unattended
alarm is 18.) The code appears in the Event log next to the time of the event.

When the row of an event is selected, the Event details frame displays the complete
timestamp of the event (date and exact time), and a brief description of the event.
When the pump is turned Off, or a power failure occurs, the pump shut-down is
registered as an event (with a time stamp), and the event log is saved.

When the number of events in the Event Log exceeds the maximum capacity, the
earlier half of the event log will be cleared, in order to allow logging of new events.

101 Vet Infusion Pump User Manual



Chapter 8: Using Advanced Features

This chapter explains how to work with less frequently used pump features. The
following options are generally reserved for more advanced pump users:

Managing Authorization Levels ......cc..cceciiiiiniiniiinieniieni e 102
Creating and Editing PreSet Programs .......ccocceveererienieieneee e 104
Using the Set Delay FEature ........coeiieieiieeeiee et 107
Using the New Patient FEature ........cociviiieiiiieeeeeee e 110
Updating to a New Pump Software Version ..........ccccoeineiieiiiiiininenne 113

Managing Authorization Levels

To help ensure patient safety, the IVVet pump can be set to one of two authorization
levels. Authorization levels control access to the programming options available in the
pump. Each level allows users to access a different set of pump actions and
programming options.

Authorization levels are modular. Therefore, users with a given authorization level can
access actions available to their level, plus all actions available to users with lower
authorization levels. The levels are:

®  High: All tasks and configuration settings are enabled, except for options limited
to technician use.

®  Technician: All settings are enabled. This level is restricted to technicians and
developers only.

0 Passwords are defined by technician.
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Specific actions allowed in each of the authorization levels are listed in the following
table.

Authorization Level Allowed Actions

High Start infusions using the New Infusion feature
View/Edit parameters
Use the Pump Configuration menu
Create/Edit PreSet programs (requires a unique password)
Changing delivery mode (requires password re-entry)
Clinician bolus

Technician All

When the pump is turned Off, the authorization lock level setting is saved. Therefore,
the lock level set most recently is maintained when the pump is turned back On.

0 If the pump is turned Off in Technician mode, the pump turns back
On in a High authorization level.

The current authorization lock level can be viewed via the Options menu. When an
infusion is running, the lock level can be accessed via the Running screen.

> To view the current authorization lock level from the Options menu:

®  From the Options menu, select View = View system.
The Authorization parameter is displayed.

> To view the current authorization lock level via the Running screen:
1. From the toolbar of the Running screen, press View/Edit.
2.  From the View/Edit screen, select View system.

The Authorization parameter is displayed.
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Setting Authorization Lock Levels

Users with an authorization level of High can reset the authorization lock level of the

pump.

> To change authorization level from a lock level of High:

1. From the Options menu, select Pump configuration - General settings.

2. Select Authorization level. Then, using the keypad, enter the High level password
- OK.
The authorization level matching the entered password, as well as all levels below
it, are listed on the Main Display.

3. Select the authorization level at which you want to lock the pump. Then, from the

Attention screen, press OK.

4. To exit the Options menu, press OK.

Creating and Editing PreSet Programs

The PreSet Programs feature allows users to start infusions using predefined infusion
parameters, thus eliminating the need for programming. Each delivery mode can
support its own set (of up to 10) predefined infusion programs. Only the infusion
programs set for the currently selected delivery mode are displayed (a preset program
is available for use and edit only when the pump is set to the delivery mode in which
the program was saved).

The following procedures explain how to create, edit and delete preset programs.

0 Creating and Editing preset programs can be done only by High
and Technician authorization levels, and in addition require a unique
password.

A PreSet program will be available for creating, using and editing only when the
program settings are consistent with the current pump settings.

> To create a new preset program:
1. From the Indicators Bar, verify that the pump is in the desired delivery mode.

2. From the Start Up screen, select PreSet Programs.
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3. From the toolbar, press Create New.
4. Using the keypad, enter the appropriate password; then, press OK.

5. Using the keypad, enter a relevant name for the new program.

® To enter the second character that appears on a key, press the key twice. (Press
3 times to enter the third character, etc.)
To enter a space, press the 0 (zero) key once.
To clear the most recently entered character, press the backspace key (left
arrow key at the lower right corner of the keypad).

® To clear all entered characters, press Clr.

After entering the name, press OK.

6. Set the relevant infusion parameters. Refer to the following table for more
information about setting parameters in each mode.

Delivery Mode Refer to:

Continuous Starting a Continuous Infusion on page 76
Multi-step Starting a Multi-step Infusion on page 92
o In PCA and PCEA PrePrograms, only the Number of Boluses limit
type is available.

/. Review the parameters displayed on the screen.

Verify that the parameters reflect the correct treatment according to
. the prescription.

Then, press OK. The program is saved.
8. To return to the PreSet programs screen, press OK.
> To edit a preset program:
1. From the Indicators Bar, verify that the pump is in the desired delivery mode.

2. From the Start Up screen, select PreSet Programs.
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From the toolbar of the PreSet Programs screen, press Edit.
Using the keypad, enter the appropriate password; then, press OK.

From the list, select the program that you want to update.

R e

Select the box of the parameter that you want to change. Using the keypad, enter
the new parameter, and then press OK.

If relevant, the pump will prompt you to confirm or update other

o parameters that may need to be modified, based on the change
made. The name of the program, drug name, drug concentration
and patient weight cannot be modified.

7. Repeat Step 6, until all relevant parameters are updated as required.

Review the parameters displayed on the screen.

Verify that the parameters reflect the correct treatment according to
the prescription.

Then, press OK. The program is saved.
> To delete a preset program:
From the Indicators Bar, verify that the pump is in the desired delivery mode.
From the Start Up screen, select PreSet Programs.
From the toolbar of the PreSet Programs screen, press Edit.
Using the keypad, enter the appropriate password; then, press OK.
From the list, select the program that you want to delete.

From the toolbar, press Delete.

No s wDd -

From the toolbar of the Attention screen, press OK.

The program is deleted.
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Using the Set Delay Feature

The Set Delay feature allows users to program an infusion in advance. When the option
is enabled, the Set Delay option appears on the Start screen. The users can then
choose to set the infusion to Standby for an unlimited time period, or to set the
infusion for a defined Delayed Period, after which one of the following occurs:

¢ |f the KVO was used during the delay period, the pump starts the infusion
automatically.

®  |fthe KVO was not used during the delay period, the alarm for the clinician sounds
to start the infusion.

0 For the Set Delay option to appear on the Start screen, the pump
needs to be configured with the Allow delayed start setting
enabled. For more information, refer to Configuring General
Settings on page 92.

> To program an infusion using the Standby option:

1. Set the relevant infusion parameters. Refer to the following table for more
information about setting parameters in each mode.

Delivery Mode Refer to:

Continuous Starting a Continuous Infusion on page 59

Multi-step Starting a Multi-step Infusion on page 72

2. From the Start screen, select Set Delay.
3. From the Delayed Start screen, select Standby.
4. The Standby screen is displayed.

Throughout the Standby period, the following information appears on the screen:

® Rate: Programmed infusion rate. For all dose units other than mL/h, the
calculated rate will be displayed in mL/h, both in the View system menu and in
the Running screen.

® VTBI: Total volume left to be infused. This parameter remains constant
throughout the Standby period.
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VI / Total: Total volume that has been infused in the current infusion / the VTBI
value programmed. These parameters remain constant throughout the
Standby period.

Time left: Time remaining until the end of the current infusion. This parameter
remains constant throughout the Standby period.

During Standby, Pump unattended alarm will not be active.

To view all of the current infusion programmed parameters, from the
Standby screen, press View/Edit > View system — Infusion
Values.

When in Standby, the pump can be turned Off without losing the
infusion parameters. To resume infusion, refer to Resuming
Infusions After Pump Shutdown on page 80.

0 To abort Standby and the infusion, from the toolbar, press End
Standby; then, from the Confirm screen, press Exit. The Start Up
screen will appear.

> To start an infusion from the Standby state:
1. Press End Standby.

2. Review the parameters displayed on the Confirm screen.

Verify that the parameters reflect the correct treatment according to
&3 the prescription.

Then, press OK.

3. Make sure that the clamps on the administration set are open; then, press Start.
The Running screen is displayed, and the infusion begins.
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> To program an infusion using the Delay Period option:

1. Set the relevant infusion parameters. Refer to the following table for more
information about setting parameters in each mode.

Delivery Mode Refer to:

Continuous Starting a Continuous Infusion on page 59

Multi-step Starting a Multi-step Infusion on page 72

From the Start screen, select Set Delay.
From the Delayed Start screen, select Delay Period.

Using the keypad, enter the desired delay period (h:min); then, press OK.

ok wN

Specify whether or not to run the infusion in a KVO, during the delay period:

0 If KVO rate is pre-configured to 0 mL/h for the delivery mode, from
the Start screen, select Start with Delay. (Refer to Do not use
KVO: below)

® Use KVO:
Press Yes — Start with Delay. The infusion begins with a KVO rate. When the
delay period is over, the programmed infusion begins immediately.

o Pressing Start during the delay period begins the infusion
immediately (overriding the delay period).

® Do not use KVO:
Press No — Start with Delay.
On the Delayed Start screen, the words No KVO appear in the Rate frame, and
a time countdown for the delay period is displayed in the Time frame.

o To override the delay period, from the toolbar, press Skip delay.
Then, from the Start screen, press Start.

When the delay period is over, an alarm sounds.
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6. To begin the infusion, verify that the clamps on the administration set are open,
and press OK; then, press Start.

When a KVO rate is not used during the delay period, the infusion
does not begin automatically when the delay period is over. You
need to begin the infusion manually, by pressing Start.

Using the New Patient Feature

The IVVet pump allows you to associate infusions to a specific patient.

When the New Patient feature is enabled, and either a New infusion, or a PreSet
program is selected, the New Patient screen appears and prompts you to indicate
whether the infusion to be programmed is for a new patient or not. Because Repeat
Last Infusion option is intended for the same patient, when selecting Repeat Last
Infusion the New Patient screen will not appear, and the pump will indicate that the
infusion to be repeated will be used for the last patient identified.

When a patient identifier is entered in the Patient ID screen, entries associated with the
patient can be tracked in the Event Log (Viewing the Event Log on page 100). In
addition, the pump calculates the accumulated volume infused (Accumulated VI) for
all infusions associated with a specific patient. When a new patient is identified, the
Accumulated VI value is automatically zeroed (for more information, refer to Monitoring
the Accumulated Volume Infused (Shift's Total) on page 111).

> To identify a New Patient:

1. From the Start Up screen of the relevant delivery mode, select New Infusion or
PreSet Programs.

2. On the New Patient screen, select Yes.

3. Using the keypad, enter the patient identifier. Then, from the toolbar, press OK.

o When a patient ID is confirmed without an identifier, the default
identifier 'PATIENT’ will be assigned as the patient identifier. The
patient identifier will appear in the Event log.
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Monitoring the Accumulated Volume Infused (Shift's
Total)

The IVVet pump calculates the Accumulated Volume Infused (Accumulated VI) for all
infusions associated with a specific patient.

The accumulated VI includes the volume infused to a specific patient via infusions
(including primary, secondary etc.), Boluses and KVO (if applied during delayed Start or
post infusion). This allows the clinical staff to monitor the total volume infused to a
specific patient. The Accumulated VI can be cleared during infusion or before starting
another infusion (for more information, refer to Clearing Accumulated VI on page 112).
The date and time in which the Accumulated VI was cleared is also captured.

The IVVet pump also provides the volume infused in the current running infusion (VI),
including KVO if applied, during a delayed start period. This VI is presented on the
running screen as well as in the message given at the end of the infusion. Clearing the
Accumulated VI automatically clears the VI.

Viewing Accumulated VI

The Accumulated VI value can be viewed before programming an infusion via the
Options menu, or during a running infusion via the View/Edit and View System menus.

> To view the current Accumulated VI value from the Options menu:
1. From the Options menu, select View = View system.

2. From the toolbar of the View system screen, press Next until the Accumulated VI
parameter is displayed.

> To view the current Accumulated VI value during infusion via the View/Edit
menu:

1. From the toolbar of the Running screen, press View/Edit.
The Accumulated VI value is presented in the Clear Accum. VI box.

> To view the current Accumulated VI value during infusion via the View Sys-
tem menu:

1. From the toolbar of the Running screen, press View/Edit.

7. From the View/Edit screen, select View system.
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3. From the toolbar of the View system screen, press Next until the Accumulated VI
parameter is displayed.

In addition to the Accumulated VI value, when using the Continuous

0 delivery mode, the View System screen also presents the
Accumulated Volume Infused via the primary line (Accum. Prim. VI)
and the Accumulated Volume Infused via the secondary line (Accu.
Sec. VI). The View system function captures the date and time in
which the accumulated VI was last cleared.

Clearing Accumulated VI

The Accumulated VI value is cleared in the following cases:

®  The pump clears the Accumulated VI automatically
® |fthe New Patient feature is disabled — Each time a New Infusion or a PreSet
Programs is confirmed (Note: Repeating the last infusion won't clear the
Accumulated VI).
® |f the New Patient feature is enabled — Each time a new patient is identified
(Note: Repeat Last Infusion is intended for the same patient; this means that a
new patient can't be identified when using the Repeat Last Infusion shortcut).

®  The user clears the Accumulated VI

® During infusion via the View/Edit screen.This will reset the total volume infused
for all infusions associated with a specific patient to 0 mL.

o The date and time in which the accumulated VI was cleared is
captured and can be viewed in the View System menu.

> To clear the Accumulated VI value during infusion:
1. From the toolbar of the Running screen, press View/Edit.
2.  From the View/Edit screen, press Clear Accum. VI.

3. From the Clear Accum. VI screen, press Yes to clear the Accumulated VI.
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Updating to a New Pump Software Version

When a new software version is available, the user is prompted to specify whether or
not to update the software.

Updating software should be conducted according to local facility
e procedures.
Updating a new software version may take a few minutes, during
which the pump is inactive.
The user is advised to connect the pump to a power supply during
the update process. If the pump is turned Off, a message appears at
the top of the screen, indicating the software download status.

> To update to a new software version: |.From the New Software screen, press
Yes.

2. Enter the installation code, and press OK. The pump will start updating the
software. At the end of the process the pump will restart.

3. The Start Up screen will appear.

> To view the current software version:1.From the Options menu, select View =
View System.

2. On the toolbar, press Next, until the SW Version parameter is displayed.
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Chapter 9: Alarms and Troubleshooting

The following sections describe the different types of alarms and messages that can be
generated by the pump, and explain how to troubleshoot common programming
issues:
AlGIMS OVEIVIEW vttt sttt ettt et ee e see e naeas 114
Level T AIBIMS oottt e
Level 2 AIAIMS oo
Level 3 AIAIMS .o
Messages ......ccceverene.
Troubleshooting

Alarms Overview

The IVVet pump generates four different types of alarms. The alarm types are
categorized according to their effect on the infusion. In all alarm types, instructions
about how to proceed (and, if relevant, to solve the problem) are displayed on the
touch screen.

Alarm Type Effect on Infusion

Level 1 Pump shuts down.

Level 2 Infusion stops and cannot be reactivated.
Level 3 Infusion stops, but may be reactivated.
Message Infusion is not interrupted.

When Level 1, 2, and 3 alarms occur, the red Alarm LED stays On continuously, and an
auditory alarm sounds continuously. These alarms require immediate attention.
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The following sections provide details about each alarm type. In the lists of alarms,
messages and alarms related to battery issues are shaded. Alarms related to battery
problems can be prevented by adhering to the recommended guidelines for battery
care (Battery Care Information on page 131).

Level 1 Alarms

This type of alarm is the highest severity alarm category. If the pump is running when
the alarm occurs, the infusion stops immediately, and the pump automatically shuts
down within 3 minutes. The infusion cannot be restarted or continued.

The following soft keys are available during a Level 1 alarm:

®  Mute: Silences the auditory alarm.

®  Shutdown: Turns Off the pump immediately.

When a Battery Depleted alarm occurs, connect the pump to an AC power supply. A
pump with an Internal Error alarm needs to be evaluated by an authorized service
technician.

Alarm Title Screen Header Displayed Text

Battery Depleted Battery Pump will automatically shut down in 3
minutes. Please connect pump to power.

Internal Error Error Pump will automatically shut down in 3
minutes. Please send the pump for service.
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Level 2 Alarms

This alarm type is a high severity category. If the pump is running when a Level 2 alarm
occurs, the infusion automatically stops.

The pump can be reactivated by a technician (using a technician authorization code) to
retrieve infusion data and/or manage a battery problem. Pumps with Level 2 alarms
need to be sent for servicing. Screen instructions are directed to technicians only.

To silence the audio signal of an alarm, press the Mute soft key. This silences the alarm
sound for 2 minutes. If the issue has not been cleared after 2 minutes, the alarm sound
will be resumed.

The following soft keys are available during a Level 2 alarm:
®  Mute: Silences the auditory alarm for 2 minutes.
®  Unmute: Returns the auditory alarm.

®  OK: Displays the Paused screen. This soft key is enabled after Mute is pressed.

Alarm Title Displayed Text

Mechanism A pump fault has occurred. Please enter technician code to proceed.

Error

Pump Fault A pump fault has occurred. Please enter technician code to proceed.
Battery End of battery life. Please contact authorized technician to replace battery.
Reminder
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Level 3 Alarms

This alarm type is a medium severity category that requires immediate attention.

If the alarm occurs during an infusion, the infusion automatically stops. However, you
may continue the infusion after the problem has been resolved. Instructions for
resolution of the problem are displayed on the touch screen.

To silence the audio signal of an alarm, press the Mute soft key. This silences the alarm
sound for 2 minutes. If the issue has not been cleared after 2 minutes, the alarm sound
will be resumed.

0 Resolving these alarms will lead to the Paused Infusion screen. If the
alarm occurs while programming a mid-infusion action, the
programming process needs to be re-initiate.

Figure 9.1. Sample Level 3 Alarm Screen
Alarm [Continuous]asss |
Air in Line

Please prme administration
set.
If problem reoccurs, remove
and reinsert the cassette

Prime:

The following soft keys are available during a Level 3 alarm:
®  Mute: Silences the auditory alarm for 2 minutes.
®  Unmute: Returns the auditory alarm.

®  OK: Displays the Paused screen. The infusion may then be resumed after the
problem is resolved. This soft key is enabled after Mute is pressed.

®  Prime: Enables automatic priming. This key appears only during an Air in Line
alarm.
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Alarm Title Displayed Text

Air in Line Accumulated air in line is over the limit. Please prime administration set. If
problem reoccurs, remove and reinsert the cassette.

Please prime administration set. If problem reoccurs, remove and reinsert
the cassette.

Possible excessive environmental light.
Please reduce exposure and check if priming is required.

Potential Air Press OK to resolve.

in Line

Cassette The administration cassette is not loaded or misplaced. Please reload the
Misplaced cassette.

Reinsert cassette. Verify both flanges inside safety door. If problem persists
contact technician.

Remove the administration cassette and make sure to correctly reinsert it. If
alarm reoccurs please contact authorized technician.

Check for Please verify clamps are open and set is not occluded.

Occlusion

Downstream To clear occlusions verify: 1. Clamps are open; 2. Administration cassette is

Occlusion properly positioned; 3. Line is not kinked; 4. No occlusion at the output
connection. If all occlusions were cleared press OK to continue.

Pump Please quit and restart the infusion.

Stopped

Flow Error Verify that the administration cassette is correctly positioned and battery is

sufficiently charged. If alarm reoccurs contact authorized technician.

Occlusion To clear occlusions verify: 1. Clamps are open; 2. Administration cassette is
properly positioned; 3. Line is not kinked; 4. No occlusion at the output
connection. If all occlusions were cleared press OK to continue.

Upstream To clear occlusions verify: 1. Clamps are open; 2. Administration cassette is
Occlusion properly positioned; 3. Line is not kinked; 4. No occlusion at the output
connection. If all occlusions were cleared press OK to continue.
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Alarm Title Displayed Text

Insufficient Low battery voltage for current rate. Please connect pump to power supply.
Battery

Messages

A Message indicates a condition of medium severity that you should attend to as soon
as possible. When a Message occurs, an auditory alarm sounds, and the condition that
triggered the message (and recommended actions, if relevant) is displayed on the
touch screen.

To silence the audio sound of a message, press the Mute soft key. This silences the
message sound for 2 minutes. If the issue has not been cleared after 2 minutes, the
alarm sound will be resumed.

Figure 9.2. Sample Message Screen

Continuous[s |

Message

The pump has been inactive
for 10 minutes

If a message is displayed during infusion, the infusion continues, and the system
continues to operate. The following soft keys are available:

®  Mute: Silences the auditory alarm for 2 minutes.

®  Unmute: Returns the auditory alarm.
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®  OK: Confirms the message, and returns the display to the previous screen. If the
infusion is complete, the pump returns to the Start Up screen. This soft key is
enabled after Mute is pressed.

If the alarm volume is configured to minimum in the Alarms menu, the OK soft key
will always be enabled.

Screen

Header Displayed Text

Low Battery 30 minutes left to battery depletion. Connect pump to power supply.
Message Battery life will expire in 2 days. Please contact authorized technician.

The battery could not be fully charged - please check power supply.
Annual certification due in 2 days. Please contact authorized technician.

Annual certification date is overdue. Please contact authorized technician.
Note: The pump continues to function after the certification date; however,
failure to perform annual certification impacts the pump warranty.

Door open. Check administration cassette position and close the safety
door.

Infusion complete.
Infusion near end.
The pump has been inactive for <xx> minutes.

System temperature is out of range. If the alarm reoccurs please contact
authorized technician.

Please Wait. Possible Downstream Occlusion. The pump is attempting to
restart; press exit to cancel.
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Troubleshooting

The following table lists some common programming issues, and explains how to solve
them.

Probable Cause

The parameter entered is
outside of the safety range
calculated by the pump.

Problem Solution

Programming cannot be
completed. The OK
function key is disabled,
and the parameter
range is in red font.

Verify the prescription, and obtain
a new one if necessary. Enter
infusion parameters within the
permitted ranges.

The Set Delay option The option is not enabled. Enable the Allow delayed start

does not appear on the
Start screen.

The PreSet Programs
option does not appear
on the Start Up screen in
any mode.

The option is not enabled.

setting (Configuring General
Settings on page 92). High
Authorization level is required.

Enable the Allow PreProgram
setting (Configuring General
Settings on page 92). High
Authorization level is required.

Pump is not charging. ® The power supply has

become disconnected
from the mini cradle.

® Verify the power supply is
connected to the mini cradle
splitter.

® The power supply was ® Disconnect and reconnect the

connected to the pump

during pump turn-off.

power supply to the pump.

® The power supply is not
working.

® |f the power supply is not
functioning properly, replace it.
Treatment is near end, or

the air detection settings
are too sensitive.

Recurring Air in Line
alarms.

Close clamps, remove
administration cassette from pump
and prime (flush) the set manually.
If the issue is not resolved, replace
the administration set.

If the issue is still not resolved,
have a technician review and adjust
the air detection settings.
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Problem

Recurring Occlusion
alarms.

Occlusion alarm is
triggered immediately
after the infusion starts.

Screen saver does not
appear.

The pump pauses when
programming a
secondary.

Probable Cause

The occlusion issue has not
been properly resolved.

The backpressure caused
by the catheter used for the
treatment, at the
programmed rate, is too
high.

® Screen saver option was
not enabled.

® Pump is not in an appli-
cable state.

The pump is not connected
to an AC outlet, and
currently the battery power
is insufficient to support
both the primary line rate
and the secondary line
programming.

Alarms and Troubleshooting

Solution

® Close clamps, remove adminis-
tration cassette from pump, dis-
connect patient and prime (flush)
the set manually.

® Replace the administration set.

® Change the infusion site.

Reduce the backpressure by either
replacing the catheter or by
decreasing the infusion rate.

® Enable the Screen Saver option
(refer to Configuring General
Settings on page 92)

® The screen saver will not appear
if the pump is in one of the fol-
lowing states: Paused, Delayed
Infusion, end of treatment KVO,
during alarm, when screen is
touched, when key is pressed, or
during a Bolus delivery

Connect the pump to an AC outlet,
and select to continue the primary
or start the secondary.
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Chapter 10: Maintenance and Storage

The following sections describe the proper cleaning, preventive maintenance, and
storage procedures for the pump and the battery:

Cleaning and Disinfecting the PUMP ..o, 124
Preventive Maintenance ..., 129
Battery Care INformation .......ooeeoieienieesiee e 131

Transport and Storage

Cleaning and Disinfecting the Pump

Between use on different patients, the [VVet pump and all of its components need to
be first cleaned, and then disinfected, per hospital/medical provider protocol for
multiple patient use.

Cleaning and disinfecting the pump involves wiping it with Dispatch® (Caltech)
ready-to-use towels.

o For cleaning, one minute waiting time.
For disinfecting, ten minute waiting time.

Additional Cleaning and Disinfection Agents:
°  Virex® 1 256
e Klor De™ (Chlorine tablets)

® 70% Isopropyl alcohol
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/. Cleaning and Disinfection: Safety Precautions

Before and during cleaning, adhere to the following safety guidelines and
recommendations:

®  Only people who are trained in the maintenance of this type of medical device
should clean the infusion pump
®  Before cleaning/disinfecting the pump, verify that:
® The pump is disconnected from the patient.
® The pump is disconnected from all connections, sets, and accessories.
® The pump is turned Off.

®  While cleaning/disinfecting the pump, do not allow fluid to enter the pump
housing, speaker holes or battery chamber.

® Do not steam autoclave, ethylene oxide sterilize or immerse any part of the pump
in fluid.

® Do not use spray or aerosol cleaners.

® Dispose of all cleaning/disinfectant materials per laws and regulations for

infectious waste disposal.

Before using materials other than the products listed above for
cleaning and disinfecting the [VVet Infusion pump, the facility must
have its cleaning and disinfection agents approved by Q Core
Medical or its local representatives. Q Core or its local
representative will let you know in writing if and when such
additional materials will be validated for use.

The pump must be completely dried out before connecting it to a
A power supply.
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Cleaning and Disinfection Procedure

Cleaning/Disinfecting Solution Manufacturer

Dispatch® (Caltech) ready-to-use towels Caltech

Virex® Il 256 Diversey

Klor DeTM (Chlorine tablets) Concept

70% lsopropyl alcohol Veltek Associates, Inc.

Cleaning Procedure

The following procedure explains how to clean the pump using the approved agents
(listed above):

> To clean the pump:
1. Turn the pump Off and unplug the power cord from the IVVet pump power socket.
2. Use the appropriate dilution ratio per the manufacturer's instructions.

3. When the solution is ready, apply the solution on a cloth or sponge, then squeeze
so it won't drip.

4. Wipe the exterior planes areas in back and forth motions, vertically and
horizontally (mainly on the pump housing).

5. The wiping should be applied with normal force, few times on the same locations
(at least twice) verifying complete coverage of the areas to be cleaned.

Guidelines for cleaning specific pump components are listed in the table below.

/. After the cleaning process is completed, the pump should be dried out for
10 minutes.

8. Wipe the pump with a clean dry cloth.

The pump must be completely dried out before connecting it to a
A power supply.
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Disinfecting Procedure

The following procedure explains how to disinfect the pump using the approved
agents (listed in Cleaning and Disinfection Procedure on page 126):

> To disinfect the pump:
1. Perform steps 1-6 specified in the cleaning process above.

2. Replace the cloth or sponge with a new one and repeat steps 3-5 (specified in the
cleaning process above) two more times (a total of 3 cycles).

3. After the disinfection process is completed, the pump should be dried out for 15
minutes.

4. Wipe the pump with a clean dry cloth.

The pump must be completely dried out before connecting it to a
A power supply.

Guidelines for cleaning/disinfecting specific pump components
Guidelines for cleaning/disinfecting specific pump components are listed in the
following table:

Component Cleaning Recommendations

LCD Screen Wipe thoroughly with a squeezed sponge. Avoid scratching the
LCD panel. Ensure that no fluid enters the speaker holes at the
top of the panel.

Sensor Fingers Clean the finger tip of the sensor using only a damp cloth or
sponge.
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Component Cleaning Recommendations

® |nternal White Panel This part should be kept free from foreign materials and dirt. If

necessary, use foam swab moistened with the detergent solution
to clean the connector, particularly around the 4 fingers roots by
applying normal finger force, assuring that the swab reaches all

® Bubble Detector (on
the internal white

panel) areas, at least twice.

® Anchor (on the inter-
nal white panel) Note: Swabbing should be applied in vertical or horizontal

® Locking tooth (on the movement, where possible, while less accessible areas should
internal white panel) be swabbed in a circular motion (at least 3 bi-directional

® P to C connector, rotations clockwise-counterclockwise).

Power communication
connector

Reprocessing the pump when used by a single patient multiple times

When the [VVet pump is used by a single patient for multiple times, the pump and all of
its components need to be cleaned first, and then disinfected using 70% Isopropyl
alcohol.

The user is required to clean and disinfect the pump in the following conditions (the
earlier of the three):

®  Every time there is visibly soiled.
®  Once aweek.

®  After storage at the patient’s home; even if not used.

Cleaning and disinfection instructions are identical to Cleaning and Disinfection
Procedure on page 126.

Maintenance and Storage 128



Preventive Maintenance

The following sections describe:
Routine Inspection and Maintenance Tasks .........ccccoceviviiiiiiiinncniccee 129
Alarm Testing
Certification

Routine Inspection and Maintenance Tasks

The following sections provide guidelines about inspecting and caring for the pump
before and after use.

Take care not to drop the pump. If the pump is dropped or appears
A to be damaged, cracked or dented, return it to your local
representative for inspection.

.

y Preliminary Inspection

Before using the IVVet pump and its accessories, check the pump for signs of any
mechanical damage.

Do not use the pump if you identify anything which may indicate

A impaired functioning of the system. In such a case, contact the
facility biomedical engineer or a Q Core approved service
technician.

Post-use Procedures

The following equipment checks should be performed following each use of the pump,
and as required:

Pump Component Action

Pump housing Check for cracks and dents.

Power cord Verify that the power cord is undamaged. Check the entire
length of the cord, and the plug.
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Alarm Testing

It is recommended to perform manual testing of the following alarms at least once a
year. Alarm testing can be conducted as part of the yearly certification.

Before testing the alarms, make sure to disconnect the set from the
A patient.
Name of Test Procedure
Air in Line Alarm Connect a new Q Core administration set to the pump without

connecting it to the infusion container. Start an infusion at a rate
of 100 mL/h. An Air in Line alarm should occur.

Occlusion Alarm Start an infusion at a rate of 600 mL/h over 5 minutes. While the
pump is running, close the upstream clamp. An Upstream
Occlusion alarm should occur.
Test the Downstream Occlusion alarm by repeating the above
test, but closing the clamp or pinching the tubing downstream
while the pump is running.

If an alarm is not generated, contact your local representative or authorized technician.

The operator should stand 1 meter from the pump, and verify that
0 he/she can hear and see the alarm.

o For more information about the Air in Line and Occlusion alarms,
refer to Level 3 Alarms on page 117.

Certification

To ensure proper fluid delivery, the pump should be checked by an authorized service
provider at least once a year, to perform yearly certification. For more information on
yearly maintenance procedures to be performed by technicians or certified service
providers, refer to the IVVet Infusion Pump Service Manual.
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Battery Care Information

The IVVet pump can operate on battery power, enabling operation of the pump during
an electrical power failure, during patient transport or during ambulatory care.

The battery charge level icon, at the upper right corner of the Indicators Bar, indicates
remaining battery capacity. Check the status of the battery charge level icon regularly:

Number of Bars in Icon Approximate Remaining Battery Capacity

5 100%
4 75%
3 50%
2 25%
1

Low

o You can also check the status of the battery using the Options
menu. For more information, refer to Viewing System
Parameters on page 98.

Battery operation time is dependent upon the condition of the battery, which varies
according to temperature conditions, battery age, frequency of charging, and
conditions of storage and use.

An alarm is triggered when there are 30 minutes left until battery depletion. This time
may depend on the delivery rate, the frequency of pressing keys, and whether the
backlight is On. When the Battery Depletion alarm sounds or following long periods of
storage, connect the pump to the power supply.

Notification messages begin appearing on the Main Display of the pump 2 weeks
before battery life expiration. When the battery life expires, the pump allows you to
finish the current infusion and then turns Off. Make sure to test the batteries at least
once a year, and replace the batteries every 2 years or every 500 charging cycles.
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Battery Classification

The UL 1642 Standard for Lithium batteries classifies the Lithium-lon battery used in the
IVVet pump as follows:

®  Secondary battery (rechargeable)

®  Technician replaceable

Battery Safety Information

When working with the battery, adhere to the safety precautions and recommendations
listed below.

Battery Safety Guidelines

®  Ensure that only Q Core Medical's rechargeable Lithium lon (Li-lon) battery is
used.

® In case of rust, bad odor, overheating, and/or other irregularities when using the
battery pack for the first time, return it to your local representative.

®  Avoid any contact with water. Do not immerse the battery pack in water.
® Do not open the battery casing.
®  Store batteries in a closed carton.

®  Short term storage temperature should be below 35°C (95°F).
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Long Term Battery Storage

When you store batteries for extended periods of time, ensure the following
conditions:

®  Well-ventilated facility, free of a corrosive gas atmosphere
®  Low humidity environment

®  Storage temperature should be between -20°C (-4°F) to +35°C (+95°F). The
recommended temperature is 23° £3°C (73° £5°F).

Storage at low temperatures may affect initial battery performance.
Storage at high temperatures may degrade battery performance.
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Charging the Battery

Before initial use of the [VVet pump, the battery must be charged for at least 6 hours.

The battery must also be charged if it has been disconnected from the pump unit for

more than 6 months. While the pump is in storage, recharge the battery at least every

12 months.

The pump can operate while it is being charged.

A

When using the pump while connected to the power supply, ensure
that the pump is attached securely to the power supply, the mini
cradle is attached securely to an IV pole, and the power cord is
secure, to prevent entanglements that might cause strangulation.

To preserve battery life, connect the pump to the main power supply using the power
supply whenever possible.

While connected to a power supply and charging, the Charge
(yellow) LED blinks, and stops blinking when the battery is fully
charged.

If the pump is turned Off, the Q Core logo appears on the screen
while the pump is charging.

A

Before charging the battery, ensure that the device is completely
dry. Failure to do so may compromise patient safety.

> To charge the battery:

1. Plug the Q Core supplied power supply cord into the main power supply.

2. With the white arrows facing up, plug the power cord into the IVVet pump power
socket or into the splitter connector.

3. On the front of the pump, verify that the Charge LED status indicator is On
(blinking yellow light).
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Battery Maintenance

To promote maximum battery life, the following procedures should be performed at
regular intervals.

Frequency Action

Following each use of the Check the status of battery charge, and recharge as
pump necessary.
Every 2 years or every 500 Replace batteries.

charging cycles

Transport and Storage

The pump should always be transported in a protective case internally padded with
cushioning material. It is best to use the original packaging. During handling and
transport, protect the pump and the case from water, excessive humidity, and heat
sources.

To safeguard the pump against prolonged exposure to dust and moisture, the pump
must be stored in a clean and dry environment. It is recommended that the pump
remain plugged in during storage, in order to maintain the battery at full charge. If the
pump is disconnected from the power supply, or is in storage without being connected
to power for several months, check the battery level, and recharge the battery before
using the pump (Charging the Battery on page 134).

For any storage period, make sure that the Q Core administration cassette is
disconnected from the pump, and that the safety door over the pump mechanism is
closed. Specific recommendations for long term storage conditions are listed in the
following table.

Condition Parameters

Temperature -40°C (-40°F) to +70°C (+158°F)
Relative humidity 15% RH to 95% RH
Atmospheric pressure 50 kPa to 106 kPa (500 hPa to 1060 hPa)
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Chapter 11: Technical Specifications

The following sections present technical specifications for the pump and its
components:

PUMP ACCUFACY ..iviiiiiiiiiiiiieiccccc e 136
PUMP SPecifications ..o 141
Environmental Specifications ............coiveiiriiiiiicieee e 143
Electromagnetic Compatibility Statement .........cccooeiiniiiiiccee 145

Pump Accuracy

The following graphs and curves were derived from the pump accuracy testing
procedures described in the IEC60601-2-24 standard. Testing was performed under
normal conditions (specified in IEC60601-2-24 standard) at room temperature (25°C,
72° F). Any deviations from normal conditions and room temperature may cause
changes in the accuracy of the pump.

Start-up and Trumpet Graphs

The start-up graphs represent startup flow versus operating time for the first two hours
from the start of the infusion. They exhibit the stability of delivery due to mechanical
compliance and provide a visual representation of uniformity. Start-up graphs were
performed according to the IEC 60601-2-24 standard.

In the IVVet pump, as in all infusion systems, the action of the pumping mechanism and
variations or external factors may cause fluctuations in rate accuracy. Conditions that
can cause flow fluctuations include:

®  Position of the infusion container
®  Fluid density

®  Positive and negative pressure

® Environmental temperature

®  Operation of the pump beyond the recommended operating limits
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Trumpet curves are named for their characteristic shape, and are developed in
accordance with IEC 60601-2-24. They display the percent flow rate deviation from the
programmed rate over time. The horizontal axis represents the observation time
intervals.

Over long observation windows, short-term fluctuation has little effect on accuracy, as
represented by the flat part of the curve. As the observation window is reduced,
short-term fluctuations have a greater effect, as represented by the "mouth" of the
trumpet. Delivery Startup Graph, First 2 Hours of Test Period, 1 mL/h

Intermittent Flow (, Q= 1 ml/h, , D= 54.02 micl)

140 +

1.20 4

Flow [mi/h]
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Figure 11.1.  Trumpet Graph, Second Hour of Delivery, 1 mL/h
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Figure 11.3.  Delivery Startup Graph, First 2 Hours of Test Period,
25 ml/h

Intermittent Flow (, @= 25 mi/h, , D= 53.32 micl)
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Figure 11.4.  Trumpet Graph, Second Hour of Delivery, 25 mL/h
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Figure 11.5.  Trumpet Graph, 24th (Last) Hour of Delivery, 25 mL/h

1%

100%

Technical Specifications 140



Pump Specifications

The following table lists and describes pump specifications.

Parameter Description

Dimensions 143 x 96 x 49 mm (5.63 x3.78 x 1.93 in.) (H x W x D)
Weight (excluding batteries) 504 g (17.8 oz.)

Pumping mechanism Single channel volumetric, with integral pressure sensor
Infusion delivery modes Continuous and Multi-step

KVO rate Up to 20 mL/h in increments of 0.1 mL/h

Accuracy +5% (Subject to external conditions such as tubing,

pressure, container position relative to the pump,
barometric pressure, humidity and temperature)

Defibrillation proof - recovery Max 1 sec
time
Flow rate 0.1-99.9 mL/h in increments of 0.1 mL/h
100 - 999 mL/h in increments of 1 mL/h
Volume (VTBI) 0.1-99.9 mL in increments of 0.1 mL
100 - 9999 mL in increments of 1 mL
Infusion device Volumetric, peristaltic
External power supply 100 - 240V 50-60 Hz, 0.6A
Battery ® Rechargeable Li-lon battery 7.4V, 1960 mA/h
® 24 hrs @ 125 mL/h (with a fully charged battery, and
backlight Off)
® Recharge time: up to 6 hrs (when pump is not in oper-
ation)
Adaptor AC Adaptor 10 VDC/2.0A
Fuse rating T1.6A, 250V
Downstream occlusion Up to 17.4 PSI (1.2 bar or 900 mmHg)
Operating temperature +5° (41°F) to 40°C (104°F)
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Parameter Description

Alarms Refer to full list of alarms in Chapter 9: Alarms and
Troubleshooting on page 114.

Prime Manual or automatic priming (600 mL/h, or from air in
line alarm 900 mL/h)

Sensors ® Air in line sensor: Detects both single and
accumulated bubbles sized 0.02-0.5 mL. The desired

size range of each option can be selected by the
technician.

® Upstream/Downstream occlusion sensor
® Door open sensor

® Temperature sensor
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Environmental Specifications

The pump should be operated within the temperature and humidity ranges specified
below. To avoid damage to the pump or battery, do not store the pump or the
administration set outside these temperature and humidity ranges. Do not store the
pump for prolonged periods with the battery installed.

Operating Conditions

Adhere to the following operating conditions:

Condition Details/Range

Operating mode Long term infusion usage
Humidity 15% to 95%

Temperature +5°C to 40°C (41°F to 104°F)
Atmospheric pressure 70 kpa to 106 kpa

Environmental Conditions for Transport and Storage
When transporting or storing the pump, adhere to the following conditions:

Condition Details/Range

Atmospheric pressure 50 kPa to 106 kPa (500 hPa to 1060 hPa)
Relative humidity 15% to 95%

Temperature -40°C to +70°C (-40°F to 158°F)

Do not disassemble the portion of the IVVet pump that houses the
pump mechanism and the electronics. This should be done by
authorized personnel only; Q Core Medical Ltd. will not be
obligated to provide technical service in such a case.
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When storing batteries separately from the pump, maintain the following storage
temperature ranges:

Type of Storage Temperature Range

Short term <40°C (<95°F)

Long term -20°C (-4°F) to +35°C (+95°F)
Recommended: 23° +3°C (73° +=5°F)

y Storage at low temperatures may affect initial battery performance.
o Storage at high temperatures may degrade battery performance.

The following list provides guidelines about environmental conditions and situations to
be avoided when working with or storing the pump:

®  Avoid locations where there is inadequate ventilation.
®  Avoid locations where sudden impact or vibration may occur.

®  Avoid damp locations, or locations where moisture level may increase
considerably.

®  Avoid locations with large temperature fluctuations.
®  Avoid locations exposed to direct sunlight.
®  Avoid locations near an electrical heating apparatus.

®  Avoid locations exposed to chemicals or explosive gases.
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Electromagnetic Compatibility Statement

The following sections provide information about testing of and recommendations for:

Electromagnetic EMISSION ...c.eiiiiirieeiieriie ettt st 145
Electromagnetic IMMUNITY .o..eoviorieee e et 146
Recommended Separation Distances from Mobile RF Communication Equipment
149

Electromagnetic Emission

The pump is intended for use in the electromagnetic environment specified below. The
customer or the user of the pump should ensure that it is used in such an environment.

Electromagnetic Environment

Emission Test Compliance Guidance

RF emission CISPR 11 Group 1 The pump uses RF energy for its internal
function only. Therefore, RF emissions are
very low and are not likely to cause any
interference with nearby electronic

equipment.
RF emission CISPR 11 Class B The pump is suitable for use in all
Harmonic emissions Class B establishments, including domestic
IEC 610003-3-2 establishments and those directly

connected to the public low-voltage
Voltage fluctuations / flicker ~ Complies power supply network that supplies
emissions buildings used for domestic purposes.
IEC 61000-3-3
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Electromagnetic Immunity

The pump is intended for use in the electromagnetic environment specified below. The
customer or the user of the pump should ensure that it is used in such an environment.

IEC 60601 Test

Compliance

Electromagnetic

Immunity Test

Electrostatic
discharge (ESD)
IEC 61000-4-2

Electrical fast
transient/burst
IEC 61000-4-4

Surge
IEC 61000-4-5

Voltage dips, short
interruptions and
voltage variations on
power supply input
lines

IEC 61000-4-11

Technical Specifications

Level

+6 kV contact
+8 kV air

*2 kV for power
supply lines
+1 kV for input/
output lines

+1 kV differential
mode

<5% UT (>95%
dip in UT) for 0.5
cycles

40% UT (60% dip
in UT) for 5
cycles

70% UT (30% dip
in UT) for 25
cycles

<5% UT (>95%
dipin UT) for5s

Leve

+8 kV contact
+15 kV air”

*2 kV for power
supply lines
+1 kV for input/
output lines

+1kV at
110 & 230 VAC

<5% UT (>95%
dip in UT) for 0.5
cycles

40% UT (60% dip
in UT) for 5
cycles

70% UT (30% dip
in UT) for 25
cycles

<5% UT (>95%
dipin UT) for5s

Environment Guidance

Floors should be wood,
concrete or ceramic tile. If
floors are covered with
synthetic material, the
relative humidity should be
at least 30%.

Mains power quality should
be that of a typical
commercial or hospital
environment.

Mains power quality should
be that of a typical
commercial or hospital
environment.

Mains power quality should
be that of a typical
commercial or hospital
environment. If the user of
the pump requires
continued operation during
power mains interruptions, it
is recommended that the
pump be powered from an
uninterruptible power
supply or a battery.
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IEC 60601 Test Compliance Electromagnetic

Immunity Test Level Level Environment Guidance
Power frequency 3 A/m 3 A/m Power frequency magnetic
(50/60 Hz) magnetic fields should be at levels
field characteristic of a typical
IEC 61000-4-8 location in a typical

commercial or hospital
environment.

* The pump was tested to the EMC requirements of IEC 60601-1-2 (third edition) and
IEC 60601-2-24 (second editior%.

Electromagnetic Immunity for Life-supporting Equipment and Systems

The pump is intended for use in the electromagnetic environment specified below. The
customer or the user of the pump should ensure that it is used in such an environment.
Portable and mobile RF communications equipment should be used no closer to any
part of the pump, including cables, than the recommended separation distance
calculated from the equation applicable to the frequency of the transmitter.

Field strengths from fixed RF transmitters, as determined by an electromagnetic site
survey, should be less than the compliance level in each frequency range.

()

Interference may occur in the vicinity of equipment marked with the symbol.

Electromagnetic

IEC 60601 Test ~ Compliance Environment
Immunity Test V] Leve Guidance
Conducted RF 3 Vrms 150 kHz 3 Vrms Recommended
IEC 61000-4-6 to 80 MHz separation distance (RSD)
10 Vrms 150 kHz _
to 80 MHz d= 1'2“/6
3Vrms T RSD d :4ﬁ
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Electromagnetic

IEC 60601 Test Compliance Environmient
Immunity Test Level Level Guidance

where p is the maximum output power rating of
the transmitter in watts (W) according to the
transmitter manufacturer, and d is the
recommended separation distance in meters

(m).
Radiated RF 3V/m 10 V/m Recommended
IEC 61000-4-3 80 MHz to 80 MHz - 2.5 GHz separation distances:
2,5GHz 80% AM, 2 Hz ® 80 MHz to 800 MHz:
80 MHz - 2.5 GHz
80% AM, 1 KHz d=4./p
® 800 MHz to 2.5 GHz:
d =77./p

At 80 MHz and 800 MHz, the higher frequency
range applies.

* These guidelines may not apply in all situations. Electromagnetic propagation is affected
by absorption and reflection from structures, objects and people.

t The pump was tested to the EMC requirements of IEC 60601-1-2 (third edition) and
IEC 60601-2-24 (second edition).

Notes

1. The ISM (industrial, scientific and medical) bands between 150 kHz and 80 MHz
are 6,765 MHz to 6,795 MHz; 13,553 MHz to 13,567 MHz; 26,957 MHz to
27,283 MHz; and 40,66 MHz to 40,70 MHz.

2. The compliance levels in the ISM frequency bands between 150 kHz and 80 MHz
and in the frequency range 80 MHz to 2.5 GHz are intended to decrease the
likelihood that mobile/portable communications equipment could cause
interference if it is inadvertently brought into patient areas.

For this reason, an additional factor of 10/3 is used in calculating the
recommended separation distance for transmitters in these frequency ranges.
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3. Field strengths from fixed transmitters, such as base stations for radio (cellular/
cordless) telephones and land mobile radios, amateur radio, AM and FM radio
broadcast and TV broadcast cannot be predicted theoretically with accuracy. To
assess the electromagnetic environment due to fixed RF transmitters, an
electromagnetic site survey should be considered. If the measured field strength
in the location in which the IVVet pump is used exceeds the applicable RF
compliance level above, the pump should be observed to verify normal operation.
If abnormal performance is observed, additional measures may be necessary, such
as re-orienting or relocating the pump.

4. Over the frequency range 150 kHz to 80 MHz, field strengths should be less than
3V/m.

Recommended Separation Distances from Mobile RF Communication
Equipment

The pump is intended for use in an electromagnetic environment in which radiated RF
disturbances are controlled. The customer/pump user can help prevent
electromagnetic interference by maintaining a minimum distance between portable
and mobile RF communications equipment (transmitters) and the pump, according to
the maximum output power of the communications equipment.

The following table provides recommended separation distances between portable
and mobile RF communication equipment and the pump (for life-supporting
equipment and systems).

For transmitters rated at a maximum output power not listed in the table, the
recommended separation distance d in meters (m) can be determined using the
equation applicable to the frequency of the transmitter, where p is the maximum
output power rating of the transmitter in watts (W) according to the transmitter
manufacturer.
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Rated Maximum

Output Power of Separation Distance According to Frequency of

Transmitter (W) Transmitter (m)

150 kHz to 150 kHz to 80 MHzto 800 MHz

80 MHz 80 MHz in 800 MHz to 2.5
outside ISM ISM bands GHz
bands
d=12/p d=4Jp d=12/p d=23/p
0.01 0.12 0.40 0.12 0.23
0.1 0.38 1.3 0.38 0.72
1 1.2 4.00 1.2 2.3
10 3.8 13 3.8 7.27
100 12 4.00 12 23
Notes
1. These guidelines may not apply in all situations. Electromagnetic propagation is

2.

affected by absorption and reflection from structures, objects and people.

At 80 MHz and 800 MHz, the separation distance for the higher frequency range
applies.
The ISM (industrial, scientific and medical) bands between 150 kHz and 80 MHz

are 6,765 MHz to 6,795 MHz; 13,553 MHz to 13,567 MHz; 26,957 MHz to 27,283
MHz; and 40,66 MHz to 40,70 MHz.

An additional factor of 10/3 is used in calculating the recommended separation
distance for transmitters in the ISM frequency bands between 150 kHz and 80
MHz and in the frequency range 80 MHz to 2.5 GHz.

This decreases the likelihood that mobile/portable communications equipment
could cause interference if it is inadvertently brought into patient areas.
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Chapter 12: Limited Warranty

Q Core Medical Ltd. (the "Manufacturer") warrants to the buyer who purchased the
IVVet directly from the manufacturer (Initial Buyer) that the IVVet Infusion Pump
("IVVet"), not including accessories, shall be free from defects in materials and
workmanship under normal use, if used in accordance with this User Manual, for a
period of one years from the actual date of sale to the Initial Buyer. THERE ARE NO
OTHER WARRANTIES. Extended warranty can be separately purchased following the
end of the two year period.

This warranty does not cover normal wear and tear and maintenance items, (such as the
Bi Annual Certification Kit), and specifically excludes batteries, administration sets,
extension sets or any other accessory items or equipment used with the [VVet. Subject
to the conditions of and upon compliance with this Limited Warranty, the Manufacturer
will repair or replace at its option without charge (except for a nominal charge for
postage and handling) any defective IVVet provided a claim is made during such two
year period.

The following conditions, procedures, and limitations apply to the Manufacturer's
obligation under this warranty:

A. Parties Covered by this Warranty: This Warranty extends only to the Initial Buyer of
the IVVet. Warranty Performance Procedure: Notice of the claimed defect must be
made by Initial Buyer in writing to the Manufacturer as follows: Q Core Medical Ltd., 29
yad haruzim St., P.O. Box 8639, Netanya, Israel 4250529. Initial Buyer should send mail
to support@cqcore.com or contact the account manager. Notice to the Manufacturer
must include date of purchase, serial number, and a description of the claimed defect
in sufficient detail to allow the Manufacturer to determine and facilitate any repairs
which may be necessary. AUTHORIZATION MUST BE OBTAINED PRIOR TO
RETURNING THE IVVet. If authorized, the IVVet must be properly and carefully
cleaned, packaged and returned to the Manufacturer. Any loss or damage during
shipment is at the risk of the sender.

B. Conditions of Warranty: The warranty is void if the IVVet has been 1) repaired by
someone other than the Manufacturer or its authorized agent 2) altered so its stability
or reliability is affected 3) misused or 4) damaged by negligence or accident. Misuse
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includes, but is not limited to, use not in compliance with the User Manual or use with
non-approved accessories. Removal or damage to the [VVet's serial number will
invalidate this warranty.

C. Limitations and Exclusions: Repair or replacement of the IVVet or any component
part therefore is the EXCLUSIVE remedy offered by Manufacturer. The following
exclusions and limitations shall apply:

1. No agent, representative, or employee of the Manufacturer has authority to bind the
Manufacturer to any representation or warranty, expressed or implied.

2. THERE IS NO WARRANTY OF MERCHANTABILITY OR FITNESS OR USE OF THE
IVVet FOR ANY PARTICULAR PURPOSE.

3. The IVVet can only be used under the instruction of medical personnel whose skill
and judgment determine the suitability of the IVVet for any particular medical
treatment.

4. All recommendations, information, and descriptive literature supplied by the
Manufacturer or its agents are believed to be accurate and reliable, but do not
constitute warranties.

The Manufacturer disclaims responsibility for the suitability of the IVVet for any
particular medical treatment or for any medical complications resulting from the use of
the IVVet. The Manufacturer shall not be responsible for any incidental damage or
consequential damages to property, loss of profits, or loss of use caused by any defect
or malfunction of the IVVet.Service Information

While under Q Core warranty, the IVVet pump must not be opened by unauthorized
personnel.

Use only an authorized Q Core service provider for service and repair. In the event that
your pump needs to be returned for service, obtain a Return Authorization by sending
mail to support@qcore.com, or contact your account manager. The pump must be
packed in a suitable container that will provide adequate protection during shipment.
To ensure prompt return, a Q Core authorized service representative must be notified
before shipping any pump for repair. When calling for service, please be prepared to
provide the serial number of the pump and software version details. A brief written
description of the problem should be attached to the pump when it is returned for
service.

Q Core Medlical Ltd. will not be responsible for unauthorized returns or for pumps
damaged in shipment due to improper packing.
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